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Торговые марки 

Логотип фирмы DCI, а также наименования DataLog
®
, DigiTrak

®
, Eclipse

®
, F5

®
, MFD

®
,
 
SST

®
, и TensiTrak

®
 являются 

зарегистрированными на территории США торговыми марками, а наименования Ball-in-the-Box™, F Series™, FSD™, и 
LWD™ являются торговыми марками фирмы Digital Control Incorporated. Наименование Bluetooth является 
зарегистрированной торговой маркой фирмы Bluetooth SIG Inc. 

Патентная информация 

Описываемые в данном руководстве изделия запатентованы в США и в других странах. Более подробная информация 
приводится на сайте фирмы по адресу: www.DigiTrak.com/patents. 

Ограниченные гарантийные обязательства 

Условия и положения Ограниченных гарантийных обязательств распространяются на все производимые и 
продаваемые фирмой Digital Control Incorporated (DCI) изделия. Копия условий Ограниченных гарантийных 
обязательств приводится в конце данного руководства. Её также можно получить в службе по работе с клиентами 
фирмы DCI по телефонам +7-499-281-8177 либо по адресу www.DigiTrak.com. 

Важное замечание 

Все утверждения, вся техническая информация и рекомендации, имеющие отношение к изделиям фирмы DCI, 
основываются на информации, которая считается имеющей достаточную степень достоверности, но несмотря на это 
фирмой не предоставляется никаких гарантий относительно точности или полноты такой информации. Перед началом 
использования любого из изделий фирмы DCI, пользователь обязан удостовериться в том, что данное изделие 
пригодно для целевого использования. Вся содержащаяся в тексте данного документа информация относится к 
изделиям фирмы DCI в такой конфигурации, в какой они поставляются фирмой DCI для их использования в операциях 
по стандартному горизонтально направленному бурению и не распространяется ни на какие выполненные 
пользователями модификации оборудования, ни на какие изделия третьих сторон и ни на какие случаи нестандартной 
эксплуатации изделий фирмы DCI. Ни одно из положений данного документа не представляет собой никаких 
гарантийных обязательств фирмы DCI и не может рассматриваться в качестве условий, изменяющих положения 
существующих Ограниченных гарантийных обязательств фирмы DCI, распространяющихся на все изделия фирмы DCI. 
Фирма DCI оставляет за собой право на внесение в данное руководство дополнений или поправок без 
предварительного уведомления. Вы можете найти последнюю редакцию данного руководства на сайте фирмы DCI по 
адресу www.DigiTrak.com. В разделе Service & Support (Обслуживание и работа с клиентами), нажмите на 
Documentation (Документация) и выберите требуемое руководство в раскрывающемся меню Manuals (Руководства). 

Заявление о соответствии требованиям 

Данное оборудование соответствует требованиям Раздела 15 правил Федеральной Комиссии Связи (FCC), а также 
промышленным стандартам RSS Канады на не требующее лицензирования оборудование и нормативам Australia Class 
License 2000 для устройств с низким потенциалом создания интерференции (LIPD). Эксплуатация оборудования должна 
выполняться с соблюдением следующих двух условий: (1) данное оборудование не может служить источником 
негативной интерференции и (2) данное устройство должно функционировать в условиях воздействия любой 
интерференции, включая такую интерференцию, которая может привести к нежелательным последствиям. Фирма DCI 
несёт ответственность за соблюдение требований Федеральной Комиссии Связи (FCC) на территории Соединённых 
Штатов: Digital Control Incorporated, 19625 62nd Ave S, Suite B103, Kent WA 98032; тел +1-425-251-0559 или 800-288-3610 
(только в США и в Канаде). 

В случае изменения или модификации любого оборудования фирмы DCI, выполненных без предварительного 
утверждения фирмы DCI и не самой фирмой, ограниченная гарантия на оборудование и разрешение ФКС на 
использование оборудование будут считаться недействительными. 

Требования СЕ 

  В соответствии с Директивой R&TTE, приёмники DigiTrak относятся к классификационной группе 
радиооборудования Класса 2 и могут не допускаться к эксплуатации в некоторых странах или эксплуатироваться только 
после получения соответствующей лицензии. Полный перечень ограничений и все требуемые заявления о 
соответствии публикуются на сайте фирмы DCI по адресу, www.DigiTrak.com. В разделе Service & Support 
(Обслуживание и работа с клиентами), нажмите на Documentation (Документация) и выберите требуемое руководство 
в раскрывающемся меню CE Documents (Документация СЕ). 

http://www.digitrak.com/patents
http://www.digitrak.com/
http://www.digitrak.com/
http://www.digitrak.com/
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Контактная информация 

США 

Штаб-квартира DCI 

19625 62nd Ave S, Suite B103 

Kent Washington 98032, США 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 факс 

dci@digital-control.com 

Австралия 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 факс 

dci.australia@digital-control.com 

Китай 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, КНР 

+86.21.6432.5186 

+86.21.6432.5187 факс 

dci.china@digital-control.com 

Европа Brueckenstraße 2 

97828 Marktheidenfeld 

Германия 

+49.9391.810.6100 

+49.9391.810.6109 факс 

dci.europe@digital-control.com 

Индия DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 факс 

dci.india@digital-control.com 

Российская Федерация Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 факс 

dci.russia@digital-control.com 

 

mailto:dci@digital-control.com
mailto:dci.australia@digital-control.com
mailto:dci.china@digital-control.com
mailto:dci.europe@digital-control.com
mailto:dci.india@digital-control.com
mailto:dci.russia@digital-control.com
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Уважаемый клиент! 

Большое спасибо за то, что Вы остановили Ваш выбор на Локационной Системе DigiTrak. 
Мы по праву гордимся оборудованием, которое мы разрабатываем и производим в штате 
Вашингтон начиная с 1990 года. Основой нашей работы является создание уникального 
высококачественного оборудования и обеспечение соответствующей поддержки со стороны 
отдела по работе с клиентами, а также обучение работе с оборудованием. 

Пожалуйста, не пожалейте своего времени и внимательно ознакомьтесь с содержанием 
данного руководства и в особенности с разделами, посвящёнными технике безопасности. 
Пожалуйста, зарегистрируйте Ваше оборудование в сети по адресу: access.DigiTrak.com. Вы 
также можете заполнить поставляемую в комплекте с оборудованием регистрационную 
карточку и переслать её по факсимиле по номеру +1-253-395-2800 или отправить по почте в 
центральное представительство фирмы DCI. 

Регистрация изделия предоставит Вам право на бесплатное обращение в службу 
поддержки по телефону (в США и в Канаде), на получение уведомлений об обновлениях 
изделия и руководства по его эксплуатации, а также поможет нам проинформировать Вас о 
возможности обновления изделия в будущем. 

Если у Вас возникнут какие-либо вопросы или проблемы, Вы всегда можете обратиться в 
нашу компанию. Наш отдел по работе с клиентами работает круглосуточно, 7 дней в 
неделю. Международная контактная информация приводится на нашем сайте. 

По мере развития отрасли горизонтального направленного бурения, мы внимательно 
следим за всеми научными разработками с целью создания нового оборудования, которое 
поможет ускорить и облегчить Вашу работу. Посетите наш сайт, если Вы хотите получить 
самую последнюю информацию о наших разработках. 

Мы с удовольствием ответим на Ваши вопросы, замечания и предложения. 

Digital Control Incorporated 
Кент, Вашингтон, США 
2015 г. 

 

Посмотрите обучающие видеозаписи системы DigiTrak по адресу 
www.youtube.com/dcikent 

file://///DCI-FS01/Shared%20Documents/Document%20Library/_In%20Dev/403-3300%20F5%20DataLog-LWD%20OM/English/access.DigiTrak.com
http://www.youtube.com/dcikent
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Важная информация о технике безопасности 

Для получения точных показаний глубины, продольного угла наклона, положения по часам и 
точного расположения точек локации, Ваша локационная система DigiTrak всегда должна 
эксплуатироваться в соответствии с правилами. Если у Вас возникнут какие-либо вопросы 
относительно эксплуатации системы, пожалуйста, обратитесь в службу по работе с 
клиентами фирмы DCI. 

Это руководство представляет собой дополнение к руководству пользователя Вашей 
локационной системы, в котором приводится более исчерпывающий перечень 
предупреждений, имеющих отношение к потенциально опасным условиям, которые могут 
привести к серьёзному травматизму персонала или к летальному исходу, а также к 
снижению темпов выполнения работ, повреждению частной собственности и к прочим 
опасным ситуациям и предупреждения, связанные с эксплуатацией оборудования для 
горизонтального бурения. Перед началом эксплуатации описываемого в данном 
руководстве оборудования Вы должны подробно и в полной мере ознакомиться с 
руководством пользователя Вашей системы. 
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Введение 

      

Данные буровых работ и давления. Приёмники F5 и Eclipse 

Система DigiTrak
 

DataLog
 

предназначена для сбора и хранения данных буровых работ на 

приёмниках F5
 

или Eclipse
 

с последующей загрузкой этих данных в компьютер для 
хранения и анализа с использованием программы Log-While-Drilling (LWD™) (Регистрация 
при бурении) фирмы DCI. Система DataLog выполняет измерение и запись следующих 
данных:  

 Глубина  

 Продольный угол наклона 

 Изменение отметки (топография поверхности земли) 

 Давление раствора (необходимо использование зонда давления раствора F5) 

 Тяговое усилие и давление раствора (необходимо использование зонда TensiTrak

) 

 Информация о направлении движения зонда (необходимо использование зонда 

устройства наведения SST

) 

В этом руководстве в основном приводится описание работы системы DataLog с 
приёмником F5, а также некоторые правила работы с системой Eclipse. Если Вы 
используете систему Eclipse Вы также должны ознакомиться с руководством пользователя 
Системы съёмки местности DataLog Eclipse DigiTrak, которое имеется на сайте фирмы DCI. 

Как указано выше по тексту, система DataLog работает с зондами TensiTrak и SST. 
Полная информация о зонде серии TensiTrak и о системе наведения SST приводится в 
соответствующих руководствах пользователя, которые имеются на сайте фирмы по адресу 
www.DigiTrak.com. 

Описываемые в данном руководстве термины и методики считаются простейшими 
методами использования локационных систем DigiTrak F5 и Eclipse. Перед использованием 
данной системы для реальных буровых работ Вам необходимо подробно ознакомиться с 
руководством пользователя Вашей системы и внимательно изучить различные функции 
меню системы DataLog на Вашем приёмнике. Если у Вас возникнут какие-либо вопросы, 
обратитесь за помощью в службу по работе с клиентами фирмы DCI. 

Установить время и число 

Перед началом регистрации данных на Вашем приёмнике F5 должно быть установлены 
правильные дата и время. Функция установки времени и даты находится в функции Settings 
(Настройки) в Главном меню. Более подробная информация об установке даты и времени 
приводится в руководстве пользователя Вашего приёмника. 

http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/
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Составные части системы 

Система DataLog DigiTrak состоит из четырёх основных частей:  

Приёмник F5 или  
Eclipse Приёмник (локатор) с меню системы DataLog, предназначенный 

для показа и для записи передаваемых зондом данных. 

Зонд F5, F Series,  
или Eclipse Установленное в буровой головке и оснащённое датчиками 

устройство с электропитанием от кабеля или от аккумулятора, 
выполняющее непрерывное измерение и передачу данных о 
положении буровой головки под землёй или об тяговое усилии 
продукта. Эта информация показывается на приёмнике F5. 

Программное 
обеспечение LWD Прикладная программа для скачивания и обработки данных 

буровых работ DataLog с приёмника. 

Переходник  
для загрузки Устройство USB, необходимое для скачивания данных с 

приёмника F5 на компьютер или инфракрасное устройство с 
последовательным кабелем, предназначенное для скачивания 
данных с приёмника Eclipse. 

Приёмник 

Приёмник выполняет контроль за положением и за глубиной зонда, а также выполняет 
запись параметров буровых работ и протягивания. Приёмник F5 может сохранить 50 
записей буровых работ (бурения) в каждом из двух типов файлов системы DataLog (данные 
о параметрах буровых работ или о давлении-тяговому усилии). После этого сохранённые 
ранее записи должны быть удалены или загружены в компьютер чтобы освободить место 
для новых записей. Каждая запись буровой работы может содержать информацию о сотнях 
реперных точек. При выполнении записи давления-тягового усилия с системой DataLog, 
количество реперных точек зависит от объёма свободной памяти в приёмнике F5. 

Приёмник Eclipse: В данном руководстве приводятся правила использования системы 
DataLog с приёмником F5. Если Вы используете систему Eclipse, пожалуйста, обратитесь к 
руководству пользователя Системы съёмки местности DataLog Eclipse DigiTrak, которое 
имеется на нашем сайте. 

Зонд 

Функция DataLog выполняет запись данных, передаваемых всеми зондами F5 и F Series, а 
также аккумуляторными и кабельными зондами Eclipse. К ним также относятся зонды F5 
TensiTrak, собирающие информацию о давлении раствора и об тяговых усилиях продукта, а 
также устройство наведения SST, передающее данные о направлении движения буровой 
головки без кабельной сетки. 

К стандартным данным, получаемым от зонда при выполнении буровых работ относятся 
показания глубины и продольного угла наклона. Зонд с функцией измерения давления 
раствора (FPT) также передаёт данные о средней, высокой и максимальной величине 
давления раствора на каждой штанге. Если Вам необходимо выполнить одновременную 
запись параметров буровых работ и давления, Вы должны включить одновременную запись 
буровой работы и давления-тягового усилия (Р-Т) в ходе работы, так как в файле давления-
тягового усилия не записываются показания глубины и продольного угла наклона. 

http://www.digitrak.com/customerservice/downloads.html
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Для выполнения записи данных должны использоваться совместимые модели зонда и 
приёмника. Приёмник F5 совместим с зондами F5 и F Series (при условии соблюдения 
требований по региональной совместимости). Приёмник Eclipse совместим только с 
зондами Eclipse. 

Программное обеспечение LWD 

Программа Log-While-Drilling (LWD™) поставляется на флэшке USB на которой также 
записано данное руководство пользователя, руководство пользователя системы, образец 
данных параметров буровых работ и драйверы Bluetooth. 

 

Флэшка USB с программой LWD  

Для установки программы необходим компьютер со следующими минимальными 
спецификациями: 

 Операционная система Microsoft
 

Windows
 

XP

, Microsoft Windows Vista


, Microsoft 

Windows 7, или Microsoft Windows 8 

 Разъём USB 

 Устройство ввода (мышь) 

 Принтер (при необходимости) 

Переходник USB Bluetooth  

Для загрузки данных приёмника к Вашему компьютеру необходимо подключить переходник 
USB Bluetooth (Модель BT-210 Amp’ed RF). Драйверы для переходника Bluetooth 
поставляются на флэшке LWD. Их необходимо установить до начала использования. См. 
Установка программы LWD на стр. 24. 

 

Переходник USB Bluetooth  

Серия Eclipse: для загрузки данных с приёмника Eclipse необходимо использовать 
инфракрасный кабель ACTiSYS. Поместите датчик инфракрасного ввода кабеля перед 
инфракрасным портом приёмника и подключите последовательный порт к компьютеру. 

Если на Вашем компьютере нет последовательного порта, Вам необходимо использовать 
переходник от порта USB на последовательный интерфейс, который поставляется в 
комплекте с инфракрасным кабелем. Драйвер фирмы Prolific для этого переходника записан 
на флэшке. 
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Описание системы DataLog 

Вид показываемого программой Log-While-Drilling стандартного отчёта зависит от тех 
данных, которые были записаны Вашим приёмником. В следующих далее разделах 
описываются пять типов отчётов, которые может составлять DataLog в режиме Log-While-
Drilling. 

Ваш приёмник выполняет запись практически всех получаемых от зонда данных при 
помощи операции Буровой системы DataLog. Данные о давлении и об тяговых усилиях 
TensiTrak записываются отдельно в файле операции Давления-Тягового усилия системы 
DataLog. Оба комплекта данных могут быть показаны на одном графике только в том 
случае, если их запись выполнялась одновременно. 

 

Примечание Перед началом, остановкой или перед продолжением операции должна 
быть включена функция DataLog. Из Главного Меню выберите функцию 

Буровой системы DataLog  и/или Давления-Тягового усилия DataLog 

, нажмите на красный значок Выключено…  после чего он 

переключится на зелёный  (включено), и нажмите на кнопку Выход 

 чтобы переключиться обратно на Главное меню. 

Стандартные данные зонда 

Для записи стандартных данных зонда, таких как номер штанги, глубина и продольный угол 
наклона, включите операцию Буровой системы DataLog (см. Запись данных на стр. 10). В 
программе Log-While-Drilling (LWD) эти данные будут показаны следующим образом: 

 

Только буровые данные 

Строка меню 

Информация об 

участке 

Информации 

об операции 

Панель инструментов 

Окно графика 

Строка состояния 

Список реперных точек 
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Стандартные данные зонда с давлением бурового 
раствора 

На экране выбора зонда выберите зонд FPT. Когда Вы включите экран Локации приёмник 
автоматически попросит Вас включить операцию P-T DataLog. После того как Вы включите 
операцию P-T DataLog и переключитесь обратно на экран Локации, ненадолго удержите 
кнопку и переключатель вправо чтобы включить одновременную операцию Буровой 
системы DataLog (см. Запись данных на стр. 10). 

 

Буровые данные с данными о давлении раствора 

Данные о давлении раствора без буровых данных 

Чтобы выполнить запись только данных о давлении раствора, включите операцию системы 
Давления-Тягового усилия DataLog как указано в предыдущем разделе, но не включайте 
одновременную операцию Буровой системы DataLog. Так как в этом случае в записи будут 
отсутствовать данные о буровых штангах и соответствующая привязка данных о давлении. 
На окончательном графике LWD будут показаны только распределённые по времени 
исходные данные о давлении раствора. 

 

Только данные о давлении раствора 

 

Глубина 

Давление раствора 
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Данные об тяговых усилиях TensiTrak и о давлении 
раствора 

Для записи давления раствора и тягового усилия при работе с зондом контроля тягового 
усилия TensiTrak

 
включите операцию P-T DataLog. Так как при выполнении операции 

протягивания продукта не используется зонд направляющей скважины, графики системы 
TensiTrak выглядят так же неровно, как и графики давлении раствора без буровых данных. 

 

Графики тягового усилия TensiTrak и давления раствора  
без буровых данных 

Более подробное описание методов использования и записи данных зонда TensiTrak 
приводится в руководстве пользователя системы TensiTrak, которая имеется на сайте 
фирмы по адресу www.DigiTrak.com.  

Давление 

Тяговое усилие 

http://www.digitrak.com/
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Данные устройства наведения (SST) 

Система DataLog не используется при записи отметок, профиля буровой трассы и углов 
отклонения влево/вправо с зондом устройства наведения (SST). Вместо этого необходимо 
использовать программу LWD на портативном компьютере, подключенном к буровой 
установке при выполнении бурения. 

 

Данные устройства наведения (SST) об отметках и о трассе в программе LWD  

Более подробное описание методов использования и записи данных зонда SST приводится 
в руководстве пользователя системы SST, которая имеется на сайте фирмы по адресу 
www.DigiTrak.com. 

Двухразмерный 

вид трассы 

Отклонение 
влево/вправо 

(вид сверху) 

http://www.digitrak.com/
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Меню системы DataLog на приёмнике 

В Главном меню приёмника F5 два раза нажмите на переключатель вниз чтобы открыть 

функции меню Буровой системы DataLog  и системы Давления-Тягового усилия (P-T) 

DataLog .    

 

Главное меню приёмника F5, Второй экран 

Меню Буровой системы DataLog 

Для записи буровых данных направляющей скважины используйте меню Буровой системы 

DataLog . 

 

Меню Буровой системы DataLog  

Буровая система DataLog 

Система Давления-Тягового 

усилия (P-T) DataLog 

Описание выделенной функции 

Удаление записи 

операции DataLog 

Добавить точку 

наблюдения 

Просмотр записей 

операций DataLog 

Настройка операции 

Буровой системы DataLog 

Загрузка данных операции Буровой 

системы DataLog в компьютер 

Включение/выключение функции 
Буровой системы DataLog (зелёный 

если функция включена, красный если 

выключена) 
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Меню системы Давления-тягового усилия (P-T) DataLog 

Для записи давления бурового раствора используйте меню системы Давления-тягового 

усилия (P-T) DataLog . Когда Вы включите экран Локации приёмник автоматически 
попросит Вас включить операцию P-T DataLog. 

 

Меню системы Давления-Тягового усилия (P-T) DataLog 

При записи операции Буровой системы DataLog выполняется запись всех данных кроме 
показаний давления раствора. Для записи показаний давления раствора и тягового усилия 
при операции протягивания системы TensiTrak используется операция P-T DataLog Чтобы 
показать данные буровых работ и Р-Т на одном отчёте, обе операции должны быть 
записаны одновременно и на одной трассе. При загрузке данных операции Буровой 
системы DataLog которые были записаны одновременно с операцией P-T DataLog, 
программа LWD автоматически загружает данные Р-Т вместе с буровыми данными.  

Включение/выключение 
функции P-T DataLog (зелёный 
если функция включена, 

красный если выключена) 

Выход 

Загрузка данных операции P-T 
DataLog в компьютер 

 

Удаление записи 

операции P-T DataLog 

Значок "р" указывает на выбор 

зонда давления раствора 
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Запись данных  

Для записи буровых данных о направляющей скважине приёмник должен получать данные 
от правильно откалиброванного зонда, как указано в Вашем руководстве пользователя. 

Убедитесь, чтобы были включены функции Буровой системы DataLog и системы Давления-
Тягового усилия DataLog, как описано в замечании на стр. 4. 

Новая операция 

 

Примечание Чтобы записать вместе с Вашей операцией Буровой системы 
DataLog данные о давлении/тягового усилии, выберите зонд FPT на 
экране выбора зонда и переключитесь обратно на экран Локации. 
Приёмник автоматически предложит Вам включить запись операции 
P-T DataLog (см. Запись данных Р-Т на стр. 22). Когда Вы 
переключитесь обратно на экран Локации, то выполните 
описываемую ниже процедуру чтобы начать одновременную запись 
операции Буровой системы DataLog. 

1. На экране Локации, нажмите и ненадолго удержите кнопку, а затем одновременно 
нажмите на переключатель вправо чтобы вывести на экран меню Старт записи 
Буровой системы DataLog.  

2. Выберите Создать Новую Операцию . 

 

Меню Старта записи Буровой системы DataLog 

Создать новую операцию 
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3. Введите с кнопочного пульта длину буровой штанги (трубы), которая будет 

использоваться в данном бурении, а затем нажмите на Ввод  чтобы записать 

эту величину как длину буровой штанги. 

 

Кнопочный пульт для ввода длины трубы (штанги) 

Принимаемая по умолчанию длина штанги - 3,05 м. Приёмник запоминает последнее 
значение длины штанги. 

4. Включается экран ввода длины первой штанги с принимаемой по умолчанию длиной. 
Эта длина вычисляется автоматически как 70% от длины Вашей трубы. Если эта 

величина соответствует Вашей трассе, нажмите на  чтобы установить её и 
перейдите на 5. 

 

Экран ввода длины первой штанги 

Ввод 

Установите длину 
первой штанги  

на принимаемую по 
умолчанию величину  

Чтобы ввести другую 
величину нажмите на 

кнопочный пульт 

Длина первой штанги 
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Примечание Если буровую головку нельзя расположить таким образом, чтобы 
прорези располагались наполовину над землёй и наполовину - под 
землёй в силу конструкции установки (как показано на предыдущем и 
на следующем рисунке), Вы всё равно можете указать это 
положение в программе LWD при обработке загруженных данных 
открыв функцию Job Information (Информации об операции) (в 
меню Edit (Правка)) и указав значение в поле Rel. Elev. (Relative 
Elevation) At Entry (Отн. Отм. (Относительная отметка) входа). 
Например, если прорези корпуса расположены на глубине 1,2 м под 
землёй, введите величину -1,2. Более подробная информация об 
этой операции приводится в описании программы Log-While-Drilling 
Изменение точки наблюдения на стр. 32. 

Для расчёта нестандартной длины первой штанги, измерьте расстояние от 
стыковочных зажимов до верхней части штанги когда буровая головка будет 
располагаться в первой реперной точке. При этом прорези корпуса должны быть 
расположены наполовину над землёй и наполовину под землёй (или относительно 
плоскости поверхности при выполнении бурения из траншеи). Уровень первой 
реперной точки представляет собой Нулевую Контрольную Отметку и как правило 
является поверхностью земли. 

Выберите кнопочный пульт, введите требуемую величину, а затем нажмите на 

Ввод . 

 

 

Измерение длины первой штанги 

Верхняя часть штанги 

Прорези на корпусе 

Длина первой штанги  

Стыковочные зажимы 

Буровая 

каретка 

Линия контрольной 

нулевой отметки  

Поверхность 

земли 
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5. При выполнении записи первой реперной точки (штанга №0), Вы можете выбрать 

Запись только продольного угла наклона  . Для записи реперной точки 

нажмите на  когда приёмник будет располагаться в диапазоне действия зонда 
(при этом нет необходимости помещать приёмник на линию локацию или в переднюю 
точку локации). 

 

Функции записи Буровой системы DataLog (Только продольный угол наклона) 

Приёмник включит два звуковых сигнала и переключится обратно на экран Локации. 

6. Переместите буровую головку к концу первой штанги и установите приёмник на 
линию локации (LL) или в переднюю точку локации (FLP). 

7. Удерживая кнопку, нажмите переключатель вправо один раз. На экране включится 
меню функций записи Буровой системы DataLog. Теперь в этом меню будут доступны 
все функции. 

  

Функции записи Буровой системы DataLog 

Запись только 

продольного угла наклона 

Запишите глубину/продольный 

угол наклона 
Запишите штангу 

без данных 

Запись только 

продольного угла наклона 
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8. Выберите один из следующих вариантов: 

 Запишите глубину/продольный угол наклона  для регистрации 
информации о глубине и о продольном угле наклона. 

 Запишите только продольный угол наклона  для регистрации 
информации только о продольном угле наклона если Вы не можете установить 
приёмник на линии LL или в точке FLP. Эту функцию можно использовать при 
выполнении бурения под арматурой, которая может привести к снижению уровня 
сигнала и к возникновению на графике неправильных топографических 
координат.  

 Если Вы не можете получить данные вследствие невозможности расположить 
{154}приёмник в диапазоне действия зонда, запишите в систему штангу без 

данных . 

Нажмите на кнопку чтобы записать вторую реперную точку (штанга №1). Приёмник 
включит два звуковых сигнала и переключится обратно на экран Локации. 

9. Продолжите бурение используя комбинацию нажатий на кнопку и на переключатель 
вправо для записи реперных точек в конце каждой буровой штанги. 

Запись частичной длины штанги 

Для работы программы Log-While-Drilling (LWD) фирмы DigiTrak необходима запись 
реперных точек, расположенных на одинаковых интервалах, например, на конце каждой 
буровой штанги. Несмотря на это условие, в случае выполнения бурения с использованием 
длинных штанг и/или при выполнении значительных изменений продольного угла наклона, 
для получения более точного профиля трассы и изменений топографии Вам может 
потребоваться запись реперных точек на частичных отрезках штанг. В программе LWD 
могут использоваться четверти, половины, три четверти и полные длины штанг. Запись 
частичных штанг можно начинать после записи штанги №1 (вторая реперная точка). 

Запись частичной длины штанги: 

1. По мере возможности расположите приёмник в точке FLP или перед головкой на 
линии LL. 

2. На экране Локации, удерживая кнопку, нажмите переключатель вправо один раз. На 
экране включится меню функций записи. 

  

Функции записи Буровой системы DataLog (Первый экран) 

Запишите глубину/продольный 

угол наклона 

Запишите штангу 

без данных 

Запись только продольного 

угла наклона 
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3. Нажмите на переключатель вниз и на второй странице выберите функцию Данные 

при Частичной штанге . 

  

Функции записи Буровой системы DataLog (Второй экран) 

4. Выберите частичную длину штанги. 

 

Экран частичной длины штанги системы DataLog 

После этого экран переключается обратно на первый экран функций записи, но на 
указателе длины штанги (см. рис. на этапе 2) вместо указателя полной длины штанги 
"Full Rod" (Полная штанга) появляется указатель частичной штанги (¼, ½, ¾ или 
окончание штанги). 

5. Выберите функцию записи глубины и продольного угла наклона (или только 
продольного угла наклона если Вы не можете расположить приёмник на линии LL или 
в точке FLP) и нажмите на кнопку чтобы записать реперную точку. Приёмник включит 
несколько звуковых сигналов и переключится обратно на экран Локации. 

6. Запишите ещё одну реперную точку на частичной длине штанги или в конце штанги. 

Если перед этим Вы записали точку на частичной длине штанги, то на экране включится 
функция "Finish Rod" (Окончание штанги). 

Данные при частичной штанги 

Просмотр/удаление 

данных штанги 

Длина штанги (полная, ¼, ½, ¾ 
или последняя штанга в 

зависимости от выбора полной 

или частичной штанги) 



DIGITAL CONTROL INCORPORATED 

16 Руководство пользователя системы DataLog/LWD™ DigiTrak 

Закрытие или прерывание операции 

Перед загрузкой в компьютер операции буровых работ и P-T должны быть закрыты. 
Закройте операцию буровой системы DataLog после того, как Вы запишете последнюю 
реперную точку и зарегистрируете последнюю штангу.  

Вы также можете прервать (поставить на паузу) операцию системы DataLog, чтобы она 
оставалась открытой пока Вы просматриваете функции меню. Все операции данных 
DataLog автоматически закрываются при выключении приёмника. 

1. Чтобы открыть меню Закрыть/Пауза записи операции DataLog, нажмите на 
переключатель вниз на экране Локации. 
 
Если Вы выполняете одновременную запись буровых данных и операции DataLog, то 
на экране сначала включится меню Закрыть/Пауза записи Буровой системы DataLog 
(как показано на рис. ниже), а затем меню Закрыть/Пауза записи P-T системы 
DataLog. 

2. Чтобы закрыть операцию системы DataLog выберите функцию Закрыть операцию 

. После этого операцию можно загрузить в компьютер (см. Загрузка данных в 
компьютер на стр. 24) или оставить для последующей загрузки (см. Продолжение 
существующей записи операции на стр. 17). 
 
-ИЛИ- 

Чтобы оставить операцию открытой, выберите функцию Пауза операции . 
После переключения обратно на экран Локации: 

 Буровая система DataLog: следующая реперная точка будет записана на этой же 
операции 

 P-T DataLog: запись данных продолжится автоматически 

 

Меню Закрыть/Пауза Буровой системы DataLog (те же функции что и в P-T) 

Чтобы записать вместе с буровыми данными топографическую информацию или 
информацию о коммунальных сетях, запишите глубину, описание, номер штанги и/или 
расстояние от точки начала трассы по каждому такому объекту вручную. Эту информацию 
можно будет добавить в комплект буровых данных в программе LWD на Вашем компьютере 
после завершения работ. 

Пауза операции Закрыть операцию 
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Примечание В приёмнике F5 можно сохранить записи 50 буровых операций и 
50 операций Р-Т. После записи 45 операций приёмник покажет 
соответствующее предупреждение. Если Вы попробуете 
сохранить более 50 операций, приёмник переключится на меню 
Старта Записи. В этом случае Вы можете либо продолжить одну 
из записей либо выйти из системы. 

Продолжение существующей записи операции 

Для того чтобы добавить данные к закрытой или поставленной на паузу операции системы 
DataLog используйте функцию Продолжить из меню Старта Записи. 

В случае включения функции Р-Т DataLog и использования зонда с датчиком давления, при 
включении экрана Локации на дисплее всегда включается меню Старта Записи P-T. Вы 
можете использовать это меню чтобы создать новую (старт записи) или продолжить 
существующую запись операции. Это меню аналогично меню функции Буровой системы 
DataLog. 

1. На экране Локации удержите кнопку и нажмите переключатель вправо один раз. 

2. Выберите функцию Продолжить… . 

  

Меню Старта записи Буровой системы DataLog (аналогично функциям меню Р-Т) 

Продолжение существующей 

записи операции 
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3. Выберите номер операции для продолжения записи. 

     

Пример списка операций DataLog  

4. Только для операций Буровой системы DataLog: выберите соответствующую 
функцию продолжения записи реперных точек на экране функций записи Буровой 
системы DataLog. 

5. Продолжайте записывать буровые штанги или частичные длины штанг в соответствии 
с приведёнными ранее в этом разделе инструкциями.  
 
Данные Р-Т продолжают записываться автоматически. 

Просмотр и удаление штанг на приёмнике 

1. На экране Локации, удерживая кнопку, нажмите переключатель вправо один раз. На 
экране включится меню функций записи. 

2. Нажмите на переключатель вниз и выберите функцию Просмотр/удаление данных 

штанги . 

  

Функции записи Буровой системы DataLog (Просмотр/удаление данных штанги) 

Значок "L" обозначает 
операцию Буровой 

системы DataLog,  
а "PT" - операцию 

давления-тягового 

усилия 

Просмотр/удаление 

данных штанги 
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3. В верхней выделенной строке списка просмотра данных штанги указывается 
последняя штанга (Вы можете удалить только эту штангу). Нажмите на кнопку чтобы 
выбрать указанную штангу (чтобы переключиться обратно на экран Локации без 
удаления реперной точки просто нажмите переключатель влево или вправо). 

  

Списка просмотра данных штанги 

4. Нажмите на  чтобы удалить реперную точку последней штанги или на Выход 

 чтобы отменить операцию и переключиться обратно на экран Локации. 

  

Экран удаления штанги 

5. Повторите эту операцию для всех штанг которые Вы хотите удалить. Выберите самую 

последнюю реперную точку из показанного на этапе 3 писка и нажмите на  чтобы 
её удалить. После того, как Вы удалите все требуемые штанги Вы можете 
переключится обратно на экран Локации нажав на переключатель влево или вправо 
в списке просмотра данных штанги. Выполните визуальный контроль соответствия 
количества использованных штанг показанному на экране списку просмотра данных 
штанги. 

Данные последней штанги 

Удалить реперную 
точку последней 

штанги 

Выход 

Точка наблюдения (указывается без 
данных, если в меню Точки 

наблюдения не будет указана 

конкретная величина) 
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Измерение и регистрация последней штанги (при 
необходимости) 

После того, как буровая головка выйдет из под земли, измерьте и зарегистрируйте длину 
последней штанги, так как эта штанга не записывается в приёмнике вместе с данными 
зонда. Введите этот размер в программу LWD вручную, после загрузки данных операции. 

Длина последней штанги это длина трубы минус длина оставшейся на установке буровой 
штанги. Например, если длина трубы 3,0 м и длина штанги от стыковочных зажимов до 
верхней части штанги составляет 1,8 м, то длина последней штанги будет 3,0-1,8=1,2 м. 

 

Измерение последней штанги 

Регистрация в Буровой системе DataLog точки 
наблюдения 

В случае наличия перепада отметок между точками входа и выхода трассы Вам может 
понадобиться добавить в данные точку наблюдения, которая будет представлять собой 
опорную точку для корректировки каких-либо погрешностей в данных продольного угла 
наклона трассы, которые могут привести к искажению её профиля. Это также позволит 
построить более точный профиль поверхности земли и трассы в программе LWD. 

Выберите функцию Добавить точку наблюденияв меню Буровая система DataLog 
Главного меню. Точку наблюдения можно также зарегистрировать в программе Log-While-
Drilling после загрузки данных (см. Изменение точки наблюдения на стр. 32). 

1. Выберите функцию Добавить точку наблюдения  в меню Буровая система 

DataLog . 

2. Выберите из показанного списка имеющихся в системе буровых операций ту, в 
которую Вы хотите добавить точку наблюдения. 

3. Выберите кнопочный пульт. 

Стыковочные зажимы 

Буровые 

штанги 

Прорези на 

корпусе 

Длина оставшейся на 

установке штанги (1,8 м) 

Поверхность земли 

(топография) 

Линия контрольной 

нулевой отметки 
Буровая  

головка 

Точка выхода 

Длина трубы  

(3,0 м) 

Буровая 

установка 

Верхняя часть 
штанги 



DIGITAL  CONTROL  INCORPORATED  

Руководство пользователя системы DataLog/LWD™ DigiTrak 21 

  

Меню точки наблюдения 

4. Используя кнопочный пульт на экране, введите определённую нивелированием 
разницу отметок между точками входа и выхода трассы. 

На кнопочном пульте есть кнопка "+/-", так как разница отметок может быть как 
положительной так и отрицательной. По умолчанию пультом принимается 
положительная разница, то есть точка выхода расположена на более высокой 
отметке чем точка входа. При необходимости изменения знака используйте кнопку +/-. 

5. Чтобы ввести указанное на экране значение как точку наблюдения, нажмите на Ввод 

. Экран переключится на меню системы DataLog. 

 

Примечание Точку наблюдения можно добавить к операции позднее, в программе 
Log-While-Drilling. См. Изменение точки наблюдения на стр. 32.  

Установите точку наблюдения 
обратно на неизвестную величину 
(программа LWD выполнит расчёт 

разницы отметок) 

Откройте кнопочный пульт 
и введите известную 

разницу отметок 
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Запись данных Р-Т 

На экране выбора зонда выберите зонд FPT. После переключения на экран Локации 
приёмник автоматически предложит создать операцию Давления-Тягового усилия (P-T) 
системы DataLog. 

Выполнение записи вместе с буровыми данными 
1. В меню Старта Записи P-T DataLog выберите функцию Создать новую операцию 

. В нижней части экрана появится новый номер операции. 

  

Меню Старта Записи P-T DataLog 

Приёмник переключается обратно на экран Локации и начинается запись данных Р-Т. 
Рядом с индикатором положения по часам включается значок записи.  

  

Значок записи данных Р-Т 

Чтобы включить одновременную запись операции Буровой системы DataLog нажмите и 
удержите кнопку и переключатель вправо на экране Локации (см. Запись данных на стр. 10). 

Создать новую операцию 
(Открывает экран Локации. 
Запись данных выполняется 
под указанным номером 

операции) 

Выход (возврат на 
экран режима локации, 

запись не включается) 
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Запись без буровых данных 

Чтобы выполнить запись только данных давления-тягового усилия, включите запись 
операции Р-Т DataLog как указано в предыдущем разделе, но не включайте одновременную 
запись операции Буровой системы DataLog после переключения на экран Локации. 

Так как в этом случае не будет записано информации о буровых штангах, на окончательном 
графике в программе LWD будут показаны только распределённые по времени исходные 
данные о давлении раствора. 

Запись флажков данных 

Флажки данных должны использоваться только с системой TensiTrak или при записи 
давления раствора без одновременной записи Буровой системы DataLog. Флажки данных 
предназначены для привязки реперных точек к конкретным физическим точкам на трассе. 

Меню записи флажков доступно только после включения операции P-T и переключения 
приёмника на экран Локации. Фирмой DCI рекомендуется выполнять запись флажков в 
важных точках трассы, например, до и после пересечения с дорогой или с рекой. Эти 
флажки помогут выполнить привязку физических мест на трассе бурения/протяжки к 
реперным точкам в файле операции Р-Т. 

1. Чтобы открыть Меню записи флажков нажмите на переключатель вправо на экране 
Локации. 

  

Меню записи флажков системы DataLog 

2. Для записи флажка выберите функцию Зарегистрировать флажок . После 

записи флажка его нельзя удалить из файла данных Р-Т. 

3. Необходимо вести отдельную запись номеров флажков и информации о тех участках, 
на которых они были записаны, например "начало бурения под дорогой" или "дальний 
край русла". Эту информацию следует добавить в файл данных P-T после его 
загрузки в Ваш компьютер. 

Зарегистрировать 
флажок (выполняет 

запись указанного на 
экране Локации 

номера флажка) 

Выход (переключает 
обратно на экран 
Локации без записи 

нового флажка)  
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Установка программы LWD  

Перечень минимальных системных требований к компьютеру для использования 
программы LWD приводится на стр. 3. 

По умолчанию программа LWD устанавливается в директорию c:\Program 
Files\DCI\DigiTrakLWD. Файлы с данными программы LWD и файлы с примерами находятся 
в директории Мои документы\DCI. Вы можете изменить эти директории во время установки 
программы. 

1. Закройте все открытые приложения.  

2. Установите флэшку LWD в разъём USB и просмотрите её содержание. 

3. Чтобы установить драйверы, откройте директорию LWD Kit и щёлкните двойным 
щелчком на файле Drivers for LWD (Драйверы LWD). 

4. Чтобы установить драйверы Bluetooth откройте директорию Bluetooth Driver и 
щёлкните двойным щелчком на файле *.exe. Если на Вашем компьютере не 
показываются расширения файлов типа .exe, щёлкните двойным щелчком на файле с 
типом Приложение. 

5. Для установки программы LWD откройте директорию программы LWD DigiTrak и 
щёлкните двойным щелчком на файле setup (setup.exe). 

После установки драйверов и программы на рабочем столе появится ярлык программы 

LWD . 

Загрузка данных в компьютер 

Для выполнения загрузки операций DataLog с приёмника F5 в Ваш компьютер Вам 
необходимо добавить приёмник F5 в список устройств Bluetooth программы LWD и 
загрузить файлы в компьютер через интерфейс Bluetooth.  

Если Вы используете систему Eclipse: Перейдите на Загрузка данных с приёмника 
Eclipse на стр. 26. 

Добавление приёмника F5 в список устройств 
Bluetooth программы LWD 

Перед подключением приёмника F5 в первый раз его необходимо добавить в список 
устройств Bluetooth программы LWD. 

1. Включите Ваш компьютер и установите в разъём USB переходник Bluetooth USB 
(Модель BT-210 Amp’ed RF).  

2. Включите приёмник F5 и выберите из Главного меню функцию Информации о 

системе .  
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3. Оставьте этот экран на дисплее или запишите серийный номер приёмника и адрес 
устройства Bluetooth. 

  

Экран Информации о системе приёмника 

4. Загрузите программу LWD двойным щелчком на ярлыке LWD  на Вашем 
рабочем столе. 

5. Откройте диалоговое окно списка устройств Bluetooth щелчком на Bluetooth  (в 
меню View > Bluetooth Device List (Просмотр > Список устройств Bluetooth)). 

6. Введите Ваш Bluetooth Device Address (Адрес устройства Bluetooth) в указанное 
поле. 

  

Диалоговое окно списка устройств Bluetooth 

7. Введите Серийный номер Вашего приёмника в поле Bluetooth Device Name 
(Наименование устройства Bluetooth). 

8. Щёлкните на кнопку Add (Добавить). 

9. Щёлкните на OK. В списке устройств Bluetooth появится Ваше устройство. 

После этого Вы можете начать загрузку данных операций. 

Адрес устройства 

Bluetooth Серийный номер локатора 
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Загрузка данных с приёмника F5  

После завершения каждой операции DataLog фирмой DCI рекомендуется загружать 
полученные данные в компьютер. 

1. Откройте меню системы DataLog, соответствующее загружаемому типу файла 

операции: буровых данных  или данных давления-тягового усилия . 

2. Выберите функцию Загрузка операции . 

3. Выберите операцию для загрузки. 

 

Примечание Данные должны начать загружаться в компьютер в течение 15 

минут. Если этого не произойдёт, то приёмник автоматически 
выключится от отсутствия действий. 

4. Загрузите программу LWD двойным щелчком на ярлыке LWD  на Вашем 
рабочем столе. 

5. Щёлкните на Новый  (в меню File > New (Файл > Новый)). 

6. Выберите тип загружаемого файла (буровые данные или данные давления-тягового 
усилия) и щёлкните OK. 

7. На показанной на экране пустой странице щёлкните на Соединение  (в меню File 
> Upload Control (Файл > Контроль загрузки)). 

8. В диалоговом окне Контроля загрузки выберите функцию Bluetooth. 

9. В раскрывающемся списке Serial Port Connection (Последовательный порт) 

выберите устройство Silicon Labs CP210x USB to UART Bridge (COM#). 

10. Выберите название Вашего приёмника в раскрывающемся списке Bluetooth. 

11. Запустите процесс загрузки щелчком на кнопку Connect to Device (Подключение к 
устройству). 

12. После завершения загрузки данных на экране включится диалоговое окно DataLog 
Job Information (Информация об Операции DataLog). Вы можете ввести требуемую 
информацию сразу или потом. 

13. Щёлкните на OK. 

Информация о новой операции будет показана в информационных полях и в окнах 
графиков программы LWD. 

Загрузка данных с приёмника Eclipse 

Для загрузки данных с приёмника Eclipse требуется использование инфракрасного кабеля 
ACTiSYS, который поставляется в комплекте с системой Eclipse DataLog, а в случае, если 
на Вашем компьютере нет последовательного порта, Вам также потребуется серийный 
переходник для USB. 

1. Подключите инфракрасный кабель ACTiSYS к последовательному порту (СОМ) 
Вашего компьютера (или к разъёму USB в случае использования серийного 
переходника для USB). 

2. Включите компьютер и приёмник. 
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3. Загрузите программу LWD двойным щелчком на ярлыке LWD  на Вашем рабочем 
столе. 

4. Щёлкните на Новый  (в меню File > New (Файл > Новый)). 

5. Выберите тип загружаемого файла (буровые данные или данные давления-тягового 
усилия) и щёлкните OK. 

6. На показанной на экране пустой странице щёлкните на Соединение  (в меню File 
> Upload Control (Файл > Контроль загрузки)). 

7. В диалоговом окне Контроля загрузки выберите функцию Infra-Red (Инфракрасный 
канал).  

8. В раскрывающемся списке Serial Port Connection (Последовательный порт) выберите 
коммуникационный порт (СОМ) к которому подключён инфракрасный кабель.  

9. В Главном меню нажмите на переключатель вправо и выберите функцию DataLog. 

10. Выберите функцию Send Data (Отправить данные). 

11. На приёмнике включится последняя записанная операция. Выберите требуемую 
операцию для загрузки. 

12. Совместите инфракрасный датчик на конце кабеля с красным инфракрасным портом 
на левой боковой поверхности экрана дисплея приёмника. Нажмите не кнопку чтобы 
включить загрузку. 

В случае успешной загрузки буровые данные незамедлительно выводятся на экран 
компьютера. 

Рекомендации по загрузке 

Фирмой DCI рекомендуется выполнять загрузку данных каждой операции два раза и 
сохранять записи под разными наименованиями. Это гарантирует наличие в программе 
LWD копии изначального файла, который можно использовать вне зависимости от тех 
изменений, которые могут быть внесены в другой файл.  

Если одна из реперных точек будет записана только с данными продольного угла наклона 
или штанги без данных, то она будет показана как точка с отсутствующими данными. В этом 
случае Вы можете вручную ввести Ваши данные либо дать программе LWD выполнить их 
автоматический расчёт. 
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Удаление операции DataLog 

1. Выберите функцию Удаление операции DataLog  в меню Буровой системы 

DataLog . 

2. Выберите кнопку для удаления одной  или всех  операций. 

   

Меню Удаления операций DataLog 

3. Если Вы удаляете одну операцию, выберите её из списка Буровых и Р-Т операций 
DataLog. 

4. На экране подтверждения выберите кнопку Подтвердить  чтобы удалить 

операцию или кнопку Выход  чтобы отменить удаление. 

 

Экран подтверждения удаления операции 

Удалённую операцию нельзя восстановить. Перед удалением операций с приёмника 
убедитесь в том, что Вы загрузили в компьютер все требуемые Вам операции. 

 

Удаление одной операции 

Удалить все операции 

Выход без удаления 

операции 

Подтверждение 

удаления операции 
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Работа с программой LWD 

Загрузка программы LWD и файлов 

Загрузите программу Log-While-Drilling (LWD™) двойным щелчком на ярлыке LWD  на 

рабочем столе. Для создания нового файла операции DataLog щёлкните на Новый  (в 
меню File > New (Файл > Новый)) и выберите конкретный тип операции для нового файла: 
данные буровых работ, давления-тягового усилия или наведения. 

Программа откроет пустую страницу записи буровых данных. Заполненная данными 
страница программы LWD выглядит следующим образом: 

 

Окно данных буровых работ программы LWD 

Чтобы открыть существующий файл системы DataLog щёлкните на Открыть  (в меню 
File > Open (Файл > Открыть)). Вы также можете напрямую открыть файл системы DataLog 
в Проводнике сделав двойной щелчок на файле буровых работ DataLog с расширением 
*.dl5 или на файле данных давления-тягового усилия с расширением *.tt5. 

В системе Справки программы LWD имеется очень большой объём дополнительных 

информационных материалов. В системе Справки  имеется подробная информация об 
интерпретации и о редактировании полей данных. При помощи функции Контекстной 

справки , Вы можете щёлкнуть на конкретном элементе экрана и получить справку об 

этом элементе.  

Многие из функций меню программы LWD аналогичны функциям других программ системы 
Windows и некоторые из них имеют отдельные значки на панели инструментов. Вы можете 
навести курсор на любой из значков в программе LWD чтобы получить подсказку с 
описанием его функции. Неактивные значки или функции меню не имеют отношения к 
загруженному типу файла системы DataLog. Полный перечень функций меню и 
соответствующих этим функциям кнопок строки меню приводится в Приложение В - Меню 

на стр. 51. Например, Вы можете щёлкнуть на Единицы измерения  (в меню Edit > 
Display Units (Правка > Единицы измерения)) чтобы переключить единицы измерения с 
десятичных футов (ф.) на метры (м). 

Строка меню 

Информация 

об участке 

Информация 

об операции 

Панель 

инструментов 

Окно графика 

Строка 

состояния 

Список 

реперных точек 
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Компоненты экрана программы LWD 

 

Информация об участке  

Для внесения изменений в эту информацию, щёлкните на Информации об участке , 
выберите функцию меню Edit > Site Information (Правка > Информация) или сделайте 
двойной щелчок на показанном внизу сегменте Информации об участке. 

   

Информация об участке на экране (слева) и в Диалоговом окне 

Все адреса и контактная информация об операции, о клиенте и о подрядчике указывается 
на распечатанном отчёте (более подробная информация приводится в разделе 
Сохранение, распечатка и отправка операций в программе LWD на стр. 46). 
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Примечание Информация об участке не изменяется для каждой отдельной 
операции чтобы не было необходимости вводить одни и те же 
данные. Если эта информация не сохраняется от операции к 
операции, в особенности это относится к операционным системам 
после Windows XP, попробуйте сделать следующее: закройте 
программу LWD, щёлкните правой кнопкой мыши на ярлык LWD на 
рабочем столе, выберите функцию меню Properties (Свойства), 
выберите вкладку Compatibility (Совместимость), отметьте флажок 
опции "Run this program as an administrator" (Выполнять эту 
программу от имени администратора) и щёлкните OK. 

Информация об операции 

Для внесения изменений в эту информацию, щёлкните на Информации об операции , 
выберите функцию меню Edit > Job Information (Правка > Информация об операции) или 
сделайте двойной щелчок на показанном внизу сегменте Информации об операции. 

   

Информация об операции на экране (слева) и в Диалоговом окне 

В разделе Информации об операции приводится статистическая информация об операции. 
Некоторые поля на этом экране нельзя изменить. 

Date (Дата) В случае с приёмником F5 дата соответствует дате 
первой загруженной реперной точки. В случае с приёмником 
Eclipse - это дата загрузки операции. В случае с 
импортированными файлами системы Eclipse - это дата 
импорта файла в программу LWD. 

Serial Number (Серийный номер) Серийный номер или ID приёмника 

Job ID  (№ операции) Присвоенный операции в приёмнике номер 

Data Points (Реперные точки) Количество записанных реперных точек 
(включая введённые вручную данные) 

Typical/Default 
Rod Length (Стандартная/принимаемая по умолчанию длина штанги) Длина 

использованных штанг 

Depth (Глубина) Использованные единицы измерения глубины: футы 
(ф.) или метры (м) 

Pitch (Продольный угол наклона) Использованные единицы 
измерения продольного угла наклона: проценты (%) или 
градусы (°) 
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Pressure (Давление) Давление в фунтах на квадратный дюйм (psi) или в 
килопаскалях (кПа) (не показано на рисунке выше по тексту) 

Entry (Точка входа) Точка входа относительно начала координат (0, 0) 
на графиках (положительное или отрицательное расстояние на 
профиле и положение слева (L) или справа (R) на плане) 

Информация о длине штанг 

Typical/Default 
Rod Length  (Стандартная/принимаемая по умолчанию длина штанги) 

Информация о длине штанг включена в загружаемые с 
приёмника F5 данные. Это поле используется для изменения 
этой длины если она была неправильно записана на 
приёмнике.

1 

First Rod Length (Длина первой штанги) Длина штанги для первой реперной 
точки (штанга №0), которая, как правило, является частичной 
длиной штанги. Эта длина вычисляется путём измерения длины 
оставшейся на установке буровой штанги от стыковочных 
зажимов до верхней части штанги в момент записи штанги №0. 

Last Rod Length  (Длина последней штанги) Длина штанги для последней 
реперной точки, которая, как правило, является частичной 
длиной штанги. Эта длина вычисляется путём измерения длины 
оставшейся на установке буровой штанги от стыковочных 
зажимов до верхней части штанги, а затем вычитанием этой 
длины из полной длины штанги. Например, если длина 
оставшейся на установке штанги 1,8 м и длина полной штанги - 
3,0 м, то длина последней штанги будет 1,2 м (3,0 м – 1,8 м = 
1,2 м). 

Изменение точки наблюдения 

Do Not Use 
Reference Elevation  (Не использовать контрольную отметку) Выберите эту функцию 

при равных отметках точек входа и выхода. Выключение этой 
галочки позволяет изменить значение в поле Reference 
Elevation (Контрольная отметка) под ней. 

Reference Elevation (Контрольная отметка) Отметка контрольной точки наблюдения 
вблизи трассы. Если Вам не требуется контрольная отметка, то 
отметьте флажок Do Not Use Reference Elevation (Не 
использовать контрольную отметку) чтобы отключить это поле. 
На графике и в списке реперных точек отметка поверхности 
земли в точке входа буровой головки будет считаться нулевой 
отметкой. В случае использования контрольной отметки её 
значение становится нулевой отметкой на графике и в списке 
реперных точек. 

                                                        

1
  В случае загрузки данных из приёмника Eclipse установите принимаемую по умолчанию длину штанг 

щёлкнув на кнопку Set Defaults (Установка значений по умолчанию). После этого данная величина будет 
использоваться для всех новых загружаемых из системы Eclipse данных. В случае внесения изменений в 
параметры отдельных файлов, эти параметры будут распространяться только на сохранённые файлы. 
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Relative Elevation at Entry (Относительная отметка входа) Расстояние по вертикали между 
линией контрольной нулевой отметки и точкой входа буровой 
головки в землю. В большинстве случаев точка входа будет 
располагаться на поверхности земли. В случае начала бурения 
в траншее эта точка расположена на дне траншеи. 

Do Not Use Exit 
Survey Point (Не использовать точку наблюдения выхода) Отметьте этот 

флажок при равных отметках точек входа и выхода. После 
этого отметка выхода будет рассчитана только исходя из 
величин продольного угла наклона, длины штанг и глубины. 

Rel. Elev. at Exit (Относительная отметка выхода) Положительная или 
отрицательная разница отметок между точками входа и 
выхода. Введите отрицательное значение если точка выхода 
расположена ниже точки входа. Не используйте знак + для 
положительных значений. Эта информация регистрируется в 
приёмнике F5 указанием точки наблюдения. 

 

 

Примечание Если бурение начинается в траншее, необходимо учесть глубину 
траншеи в параметре Rel. Elev. At Entry. Чтобы учесть глубину 
траншеи относительно контрольной отметки необходимо изменить 
данные штанги №0. Если Вы не используете контрольную отметку, 
отредактируйте данные штанги №0 чтобы учесть глубину траншеи 
в качестве относительной отметки входа. 

Список реперных точек 

Список реперных точек представляет собой таблицу с перечислением всех реперных точек 
операции. В этой таблице Вы можете вставить, исправить, удалить, спрятать или убрать 
отдельные реперные точки. Указанные в таблице столбцы зависят от типа загруженного 
файла системы DataLog. Более подробная информация приводится в разделе Компоненты 
экрана программы LWD на стр. 30 и в разделе Особенности файлов Давления-Тягового 
усилия системы DataLog на стр. 41. 

Окно графика 

В окне графика показывается графический вид данных из списка реперных точек. На 
графике не показываются удалённые или спрятанные реперные точки. Показанные данные 
зависят от типа файла системы DataLog и от собранных данных. При загрузке файлов 
буровых данных на экране показывается профиль трассы. В случае использования системы 
FPT на нём также показывается график давления. При загрузке файлов с данными 
давления-тягового усилия программа показывает график давления. В случае использования 
зонда TensiTrak также показывается график усилий. При загрузке файлов системы 
наведения (в данном руководстве не включено описание этой системы) программа 
показывает профиль и план трассы.  

Общие показатели всех графиков: 

Реперные точки Не удалённые и не спрятанные реперные точки 

Величины  Величины указанных в окне графика точек 
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Координаты курсора Чтобы проверить координаты любой точки графика поместите 
курсор в требуемую точку. Чтобы просмотреть данные 
отдельной реперной точки наведите курсор на требуемую точку.  

Увеличение Для увеличения графика удерживайте кнопку Control и 
перетащите курсор по той зоне, которую Вы хотите увеличить. 
Для возврата на стандартный масштаб нажмите на кнопку 
Control и щёлкните в любой точке графика. 

Редактирование и добавление пояснений к графикам 

В программе имеется несколько способов редактирования и добавления пояснений к 
профилям трасс и к графикам давления и тягового усилия. Например, Вы можете 
использовать функцию Annotations (Примечания) в меню Edit (Правка) чтобы добавить 
геометрические фигуры или подписи непосредственно на график с целью описания условий 
выполнения операций и прочих моментов. Вы также можете использовать функцию 
Properties (Свойства) чтобы изменить границы графиков.  

Добавление геометрических фигур и подписей 

Чтобы добавить на график и на распечатку отчёта геометрические фигуры и 
дополнительную информацию, нажмите и удерживайте кнопку Shift и нарисуйте 
прямоугольник в том месте графика, где Вы хотите поместить фигуру. После этого 
программа откроет диалоговое окно примечаний в котором будут указаны координаты 
положения прямоугольника. 

  

Диалоговое окно примечаний 

Вы также можете щёлкнуть на Профиль , Давление , или на Примечания графика 

усилий  (все эти функции также находятся в меню Edit (Правка)) и введите координаты 

точки вручную. 
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Чтобы изменить свойства примечаний Вы также можете щёлкнуть на них двойным щелчком 
(этот метод не работает с подписями - только с отдельными объектами).  

Выберите из раскрывающегося списка требуемую Shape (Фигуру). При необходимости, 
измените Line Weight (Толщину линии) и Font Height (Размер шрифта). Для выбора 
свойств и цветов фигур используйте флажки и двойные щелчки на многоточиях в разделе 
Draw Shape (Нарисовать Фигуру). 

Чтобы включить раздел Caption (Подписи) поставьте галочку на флажке Draw Caption 
(Нарисовать подпись). Для подписи не надо добавлять фигуру. По умолчанию подписи 
устанавливаются по центру фигуры. Чтобы изменить положение или ориентацию подписи 
используйте поля Top - Left (Сверху-Слева) и Text Slope (Наклон текста). 

Правка свойств графика 

Если Вам необходимо изменить такие свойства графика как внешние границы и масштаб, 

щёлкните на Профиль , Давление , или на Свойства графика усилий  (все 
эти функции также находятся в меню Edit (Правка)). 

 

Диалоговое окно свойств профиля трассы 

Если Вы хотите указать другие координаты границ графика, удалите галочки из одного или 
из обоих флажков Auto Scale (Автоматического масштаба) и введите требуемые значения. 

Список реперных точек 

Список реперных точек представляет собой таблицу в которой последовательно указаны 
все реперные точки операции и все связанные с ними данные. Единицы измерения глубины 
и продольного угла наклона указываются в окне Job Information (Информация об операции). 
Таблица состоит из следующих столбцов: 
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Номер штанги (Номер штанги) Номер штанги и режим реперной точки. Режим 
данных реперной точки отмечается цветным флажком:  

 Красный флажок: Нет данных продольного угла наклона. 
Введите продольный угол наклона чтобы обеспечить 
правильный расчёт трассы. 

 Пурпурный флажок: Нет данных о глубине. Напоминание 

оператору о том, что в этой точке имеются только данные о 
продольном угле наклона. Откройте диалоговое окно Edit 
Data Point (Правка данных реперной точки) и щёлкните на 
ОК чтобы переключить этот флажок на синий или зелёный в 
зависимости от введённых оператором данных о глубине. 

 Синий флажок: Означает наличие исправленных данных 
реперной точки 

 Серый флажок: Спрятанные или удалённые данные 

 Зелёный флажок: Означает, что данные были 
перезаписаны 

 Чёрный флажок: Изначальные данные 

Rod Len. (Дл. штанги) Длина штанги 

Bore Len. (Дл. трассы) Длина трассы (сумма всех предыдущих длин штанг 
плюс длина текущей штанги) 

X Dist. (Расст. Х) Расстояние по горизонтали от точки входа  

Pitch (Продольный угол наклона) Записанный в указанной реперной 
точке продольный угол наклона 

 

Rel. Depth (Отн. глубина) Глубина буровой головки относительно линии 
нулевой отметки.  

Depth (Глубина) Расстояние от буровой головки до поверхности 
земли. Это расстояние может быть измерено, введено 
пользователем вручную или вычислено программой LWD 
методом интерполяции исходя из введённых или 
отсутствующих данных. 

Буровая 

установка 

Точка входа  

Буровые 

штанги 

Длина штанги 

Отн. глубина 
Линия нулевой 

отметки 

Буровая 

головка 

Поверхность земли 

(топография) 

Глубина 

Отн. отметка 
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Rel. Elev. (Отн. отметка) Положительное или отрицательное расстояние 
по вертикали от линии нулевой отметки. 

Date/Time (Дата/время) Дата и время записи указанной реперной точки. 
Эта информация не показывается на распечатке отчёта. 

Type (Тип) Информация относительно типа данных, записанных на 
конкретной реперной точке: 

 BL: (Blank) Без данных (на данной реперной точке нет 
данных о продольном угле наклона или о глубине)  

 PO: (Pitch Only) Только продольный угол наклона  

 LL: (Locate Line) Линия локации  

 FLP: (Front Locate Point) Передняя точка локации  

 IN: (Inserted) Добавленная реперная точка. Данные о 
продольном угле наклона и о глубине интерполируются по 
данным соседних точек и по умолчанию не показываются 
на графике. При необходимости Вы можете изменить эти 
данные перезаписав указанные по умолчанию данные. 
Новые реперные точки показываются в алфавитном 
порядке (то есть первая добавленная вручную точка после 
штанги №2 будет указана как точка 2-А, вторая - как 2-В и 
т.д.). 

RawDepth (Исходная глубина) Показанная на приёмнике расчётная 
глубина 

RawDist (Исходное расстояние) Горизонтальное расстояние от точки 
FLP или от линии LL до верхней линии. 

Comment (Примечания) В этот столбец можно добавить любые 
примечания по отдельным реперным точкам (см. раздел Правка 
штанги/реперной точки ниже по тексту). 

Символы в списке реперных точек предназначены для указания различных типов данных: 

o (overwritten) перезаписанные вручную данные  

e (edited) исправленная длина штанги  

i (interpolated) интерполированные данные  

f (filled in) добавленные данные, в загруженном файле эти 
данные отсутствовали  

h (hidden) спрятанные данные  

x Отсутствующие данные о продольном угле наклона  
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Правка реперных точек 

Если Вы щёлкнете правой кнопкой мыши на реперной точке, в таблице на экране включится 
всплывающее меню с функциями Edit (Правка), Insert (Вставить), Delete (Удалить), Hide 
(Спрятать) и Remove (Убрать). 

 

Контекстное меню таблицы реперных точек 

Правка штанги/реперной точки 

Щёлкните правой кнопкой мыши на реперной точке и выберите функцию Edit или просто 
сделайте двойной щелчок на реперной точке в списке или на графике. При необходимости, 
введите изменения или добавьте примечание. Щёлкните на OK чтобы сохранить изменения 
или на Cancel (Отменить). 

  

Диалоговое окно правки реперной точки 

Если в списке имеется реперная точка, но данные о продольном угле наклона отсутствуют 
или неизвестны, то этот флажок Pitch is Missing/Unknown (данные продольном угле 
наклона отсутствуют или неизвестны) отмечается автоматически. Ели Вы удалите галочку 
из флажка, но не укажете правильного значения продольного угла наклона, то на графике 
появится пробел в данных. Реперная точка с отсутствующими данными будет выделена на 
графике. 

В случае добавления новой штанги или штанги без данных, а также при вводе реперной 
точки только с данными продольного угла наклона система по умолчанию отмечает флажок 
Depth is Hidden/Unknown (Данные о глубине отсутствуют или неизвестны). Если Вы не 
введёте величину глубины и удалите галочку из флажка, то на графике данных появится 
пробел и отсутствующая реперная точка не будет показана.  

Флажок отмечается 
автоматически при вводе 
штанги без данных или только 

с продольным углом наклона 

Флажок отмечается 
автоматически при вводе 

штанги без данных 

Длина штанги указывается в 
тех же единицах, что и 

показания глубины 
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Чтобы восстановить записанные изначально данные нажмите на кнопку Restore Default 
(Восстановить принимаемые по умолчанию данные) рядом с теми данными, которые Вы 
хотите восстановить. 

Ввод штанги/реперной точки 

Щёлкните правой кнопкой мыши на реперной точке, которая расположена перед новой 
реперной точкой которую Вы хотите ввести и выберите функцию Insert. В списке и на 
графике появится новая реперная точка.  

Новая реперная точка будет иметь тот же номер, что и предыдущая, только с добавленной 
буквой. Например, первая введённая вручную после точки №2 реперная точка будет 
называться 2-А, следующая - 2-В и т.д. Указанные величины продольного угла наклона и 
глубины будут вычисляться интерполяцией между соседними точками и величина глубины 
будет скрыта по умолчанию. Тип штанги для введённых данных указывается под кодом "IN". 
При необходимости, Вы можете изменить расчётные данные.  

Чтобы восстановить изначальные, рассчитанные методом интерполяции данные, щёлкните 
на функцию Restore Default (Восстановить принимаемые по умолчанию данные) в 
соответствующем поле. 

Удаление добавленных штанг/реперных точек 

Щёлкните правой кнопкой мыши на той реперной точке которую Вы хотите удалить и 
выберите функцию Delete. Реперная точка будет удалена из списка и с графика.  

Изначальные данные нельзя удалить. В случае, если по ошибке одна штанга будет 
записана два раза, выберите функцию Remove (Убрать) чтобы удалить соответствующую 
реперную точку. 

Для системы Eclipse: Загруженные с приёмника Eclipse данные считаются исходными и их 
нельзя удалить. 

Hide (Спрятать) 

При выборе этой функции реперная точка остаётся в списке, но не показывается на 
графике. Соответствующие данные всё равно учитываются в расчётах. Рядом с этой 
функцией меню указывается галочка. 

Remove (Убрать) 

Эта функция предназначена для удаления реперной точки из списка, с графика и из 
расчётов. Вы можете использовать её когда исходные данные были записаны по ошибке 
два раза. 

Профиль трассы  

Профиль трассы представляет собой визуальное изображение данных системы DataLog. 

 

Профиль буровых данных 
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Реперные точки  

Реперные точки показываются на профиле трассы в виде синих точек. Для просмотра 
данных, записанных в конкретной реперной точке наведите на неё указатель мыши. Для 
вывода на экран соответствующей строки таблицы реперных точек щёлкните на реперной 
точке на профиле трассы. Пробелы в ряду реперных точек означают отсутствие данных. 

Выделение реперных точек (наличие за точками серых кругов) указывает на 
дополнительный ввод штанги или на правку данных продольного угла наклона.  

Для зелёных точек, которые обозначают поверхность земли, можно изменить только 
значения глубины. После выполнения правки эти точки также будут выделены. 

Иногда бывает полезно спрятать реперную точку на графике, так как она может 
загораживать другие элементы, такие как флажки коммунальных сетей. Спрятанные на 
профиле трассы реперные точки всё равно показываются в списке реперных точек. 

Флажки коммунальных сетей 

Используйте флажки коммунальных сетей чтобы отметить на графике и на распечатке 
отчёта положение и тип коммунальных сетей. Чтобы добавить или исправить флажок 
коммунальных сетей, откройте диалоговое окно Флажков коммунальных сетей щелчком на 

Правку флажков коммунальных сетей  (в меню Edit > Utility Flags (Правка > Флажки 
коммунальных сетей)). Вы также можете нажать на кнопку Shift и щёлкнуть на реперной 
точке на графике. При этом откроется диалоговое окно с автоматически указанными 
параметрами положения и нового флажка в указанной точке. 

 

Диалоговое окно Флажков коммунальных сетей 

Поля диалогового окна Флажков коммунальных сетей имеют следующие значения: 

Type (Тип) Выберите тип флажка из раскрывающегося списка. 
Флажок будет показан на графике в виде кружка и его цвет 
будет соответствовать рекомендуемому цвету маркировке 
сетей Американской Ассоциации Коммунальных Предприятий 
(APWA). 

X Dist (Distance)  (Расст. X. (Расстояние)) Горизонтальное расстояние по 
поверхности земли от точка входа до коммунальной сети 

Depth (Глубина) Расстояние по вертикали от поверхности земли до 

коммунальной сети 
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Comment (Примечания) По умолчанию в этом поле записывается тип 
сети. Если Вы хотите создать новую подпись введите своё 
примечание. 

Text Slope (Наклон текста) Угол наклона текста подписи на графике 

При работе с файлами давления-тягового усилия соблюдайте осторожность чтобы не 
перепутать флажки коммунальных сетей с флажками данных, которые добавляются 
оператором приёмника по мере регистрации данных. 

Особенности файлов Давления-Тягового усилия 
системы DataLog 

В дополнение ко всем перечисленным в начале предыдущего раздела пунктам, в файле 
Давления-Тягового усилия содержится информация и специальные отметки, имеющие 
отношение к регистрации давления бурового раствора (эта информация получается от 
зонда с датчиком давления) и к тяговое усилие (получаемым от зонда системы TensiTrak). 

Не забывайте: для того, чтобы получить наиболее стандартный график, типа того, который 
показан на стр. 5, одновременно с записью данных о давлении раствора выполняйте запись 
передаваемых стандартным зондом данных Буровой системы DataLog. 

Информация об операции 

Если Вам необходимо добавить или исправить показываемую на распечатке информацию 
об операции - такую как использовавшиеся в ходе операции проектные пороговые значения 
давления или тягового усилия, тип установленного для операции TensiTrak продукта и 

направление графика - щёлкните на функцию Информации об операции  (в меню Edit 
> Job Information (Правка > Информация об операции)) или сделайте двойной щелчок на 
окне Job Information. 

  

Диалоговое окно Информации об операции Давления-Тягового усилия 

Максимальные расчётные нагрузки 

Эта функция позволяет установить максимальные допустимые величины давления и/или 
усилия вытягивания) для во время выполнения операции показателей. Максимальные 
расчётные нагрузки показываются на распечатке отчёта. 

Use Tension Design Limit  (Использовать максимальное расчётное тяговое усилие) 
Выберите эту функцию если Вы хотите ввести величину 
максимального допустимого при выполнении проекта тягового 
усилия. 
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Use Pressure Design Limit (Использовать максимальное расчётное давление) Выберите 
эту функцию для установки максимального допустимого при 
выполнении проекта давления раствора. 

В случае установки максимальных расчётных нагрузок реперные точки в списке и на 
графике будут выделяться жёлтым или красным цветом в зависимости от приближения или 
превышения указанных величин. 

Информация о продукте 

Material (Материал) Информация о материале, установленном для 
проведения операции TensiTrak. 

Length (Длина) Суммарная длина продукта, установленного в ходе 
операции протягивания продукта. 

Diam (Диам.) Диаметр установленного продукта 

Right to Left или  
Left to Right  (Справа налево или слева направо) Направление отсчёта при 

показе данных на графике. Для обеспечения точности 
сравнительного анализа, данные на графике должны 
показываться относительно направления направляющей 
скважины. При протягивании продукта из выхода 
направляющей скважины выберите Right to Left (Справа 
налево). В случае, если данные давления и/или тягового усилия 
записывались начиная со входа направляющей скважины 
выберите Left to Right (Слева направо). 

Список реперных точек 

Список реперных точек представляет собой таблицу в которой последовательно указаны 
все реперные точки операции и все связанные с ними данные. Единицы измерения 
давления и усилий указываются в окне Job Information (Информация об операции). Таблица 
состоит из следующих столбцов: 

Data Point (Реперная точка) Номер и режим реперной точки. 

Force (Тяговое усилие ) Величина усилия, записанная приёмником в 
конкретной реперной точке. Указатель "Х" означает отсутствие 
данных. 

Max F. (Макс. усилие) Максимальная величина усилия, записанная 
приёмником по всем реперным точкам до указанной точки. 
Указатель "Х" означает отсутствие данных. 

Pres. (Давление) Величина давления, записанная приёмником в 
конкретной реперной точке. Указатель "Х" означает отсутствие 
данных. 

Max P. (Макс. давление) Максимальная величина давления, 
записанная приёмником до момента записи указанной точки. 

Data Flag (Флажок данных) Указывает на наличие записи флажка на 
приёмнике F5 в указанной реперной точке. 

Date/Time (Дата/время) Дата и время записи указанной реперной точки. 
Эта информация не показывается на графиках или на 
распечатке отчёта. 
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Удаление реперных точек 

Щёлкните на график в том месте, где Вы хотите убрать реперные точки. Список реперных 
точек переключится на ближайшие к выбранному участку реперные точки.  

 Чтобы выбрать несколько последовательных реперных точек нажмите на первую, затем 
нажмите и удерживайте Shift и щёлкните на последнюю. Все расположенные между 
ними точки будут выбраны автоматически.  

 Чтобы выбрать реперные точки которые не расположены последовательно, нажмите и 
удерживайте Control и щёлкните поочерёдно на все требуемые точки. 

Щёлкните правой кнопкой мыши на выбранных реперных точках и выберите функцию 
Remove (Убрать). На списке реперных точек появятся указатели того, что эти точки были 
удалены с графика. 

График давления  

На графике давления показывается давление бурового раствора в скважине. Показания 
давления записываются каждые четыре секунды, а данные, полученные в конце каждой 
штанги отмечаются зелёной точкой. В случае установки порогового значения давления 
реперные точки будут выделяться пурпурным или красным цветом в зависимости от 
приближения или превышения порога давления. В данном случае порог давления был 
установлен на величине 150 ф/д

2
 (см. раздел Информация об операции на стр. 41). 

 

График давления бурового раствора 

Давление раствора на графике операции P-T DataLog представляет собой довольно 
неровную прыгающую линию, как показано на рисунке выше по тексту. Для того, чтобы 
график имел более ровный вид выполните одновременную запись данных буровой системы 
DataLog (см. раздел Запись данных Р-Т на стр. 22). 

Реперные точки  

Синие Нормальные реперные точки 

Красные В данной точке были превышены максимальные расчётные 
величины давления или усилий.  

Пурпурные Показатели в данной точке находятся в пределах 5% от 
указанных максимальных расчётных величин давления или 
усилий. Ввод максимальных расчётных величин выполняется в 
диалоговом окне Информация об операции, показанном на 
стр. 41. 

Оранжевые Точка с максимальным зарегистрированным до этой точки 
показателем давления (усилий)  

Реперные точки в которых показатели давления были зарегистрированы в пределах 15% от 
максимально допустимых автоматически указываются на распечатке отчёта. Чтобы 
изменить этот автоматический выбор щёлкните на реперной точке в списке правой кнопкой 
мыши и выберите Print (Распечатать) или Don't Print (Не распечатывать). 
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Вы можете выбрать сразу несколько реперных точек как указано в разделе Удаление 
реперных точек на стр. 43. 

Несмотря на то, что Вы можете удалить реперные точки с графика, они всё равно останутся 
в списке реперных точек и будут отмечены кодом "-X". Эта функция может быть полезной в 
тех случаях, когда регистрация данных выполнялась при неподвижной буровой установке. 
Данные можно восстановить на графике в любое время. 

Флажки данных 

Выделение реперных точек зелёным кольцом означает, что в этих точках оператором 
приёмника были добавлены флажки данных. Цвет, метки и местоположение флажков 
данных можно изменить в диалоговом окне Флажков Данных Давления-Тягового усилия 

щелчком на функцию Флажки данных  (в меню Edit > Data Flags (Правка > Флажки 

данных), или щелчком правой кнопкой мыши на реперной точке в списке и выбором 
функции Add Data Flag (Добавить Флажок данных), или двойным щелчком мыши на 
имеющемся флажке данных).  

 

Диалоговое окно флажков данных Давления-Тягового усилия 

В случае использования датчика давления при бурении направляющей скважины и 
одновременной записи файла данных буровых работ, как показано на рисунке выше, с 
каждой новой или удалённой штангой система записывает флажок данных с 
соответствующей маркировкой "NewRod" (Новая штанга) или "DelRod" (Удалённая штанга). 
Вы можете прятать и показывать флажки данных новых и удалённых штанг на графике 
давления. 

Введённые вручную оператором приёмника флажки данных, вне зависимости от того, были 
они введены во время бурения направляющей скважины или в ходе операции протягивания 
продукта, отмечаются на графике номером флажка, который был записан во время их 
ввода. Эти флажки показаны на графике тягового усилия в следующем разделе. 

Флажки данных введённые в программе LWD называются флажками пользователей. Вы 
можете добавить примечания к флажкам пользователей и к флажкам, записанным в 
процессе сбора данных. Записанные оператором в процессе сбора данных флажки нельзя 
удалить.  

 

Примечание Не перепутайте флажки данных с флажками коммунальных 
сетей. Флажки коммунальных сетей не указываются в файле 
данных давления-тягового усилия. 

Локационная реперная точка 

будет показана на графике  
Наличие отметки означает, 
что соответствующий 
флажок не будет показан 

на графике 
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В диалоговом окне флажков данных Давления-Тягового усилия имеются следующие поля: 

Raw DP Index (Исходный код РТ) Номер реперной точки в списке всех 
реперных точек. Этот номер нельзя изменить 

Show At Pressure (Показать при давлении) Определённое давление при 
достижении которого данный флажок данных будет показан на 
графике. Если галочка не проставлена, то флажок на графике 
не показывается 

Show At Force (Показать при усилии) Определённое усилие при достижении 
которого данный флажок данных будет показан на графике. 
Если галочка не проставлена, то флажок на графике не 
показывается 

Draw Flag (Нарисовать Флажок) Для выбора свойств и цветов фигуры 
используйте флажки и двойные щелчки на многоточиях в 
разделе Нарисовать Флажок. 

Щёлкните на кнопку Change (Изменить) чтобы сохранить все изменения в файле, а затем 
на OK чтобы выйти из окна. Если Вы просто щёлкните на OK, диалоговое окно закроется 
без сохранения изменений.  

Изменённый флажок показывается на графике в виде кольца выбранного Вами в разделе 
Draw Flag цвета. 

Указываемая по умолчанию подпись включает номер и тип флажка данных. Вы можете 
ввести другую подпись в поле Comment (Примечания) и изменить угол наклона текста 
подписи в поле Text Slope (Наклон текста). 

По умолчанию флажок данных показывается при том давлении (усилии), которое было 
зарегистрировано в момент записи или добавления флажка. Если Вам необходимо 
переместить отметку от зарегистрированных показателей, Вы можете использовать флажки 
секции Show At… (Показать при…). 

График тягового усилия 

График тягового усилия показывается только для операций системы TensiTrak. На нём 
показываются зарегистрированные в каждой реперной точке тягового усилия продукта. По 
мере приближения и превышения пороговых показателей усилий реперные точки будут 
выделяться жёлтым или красным цветом. В приводимом ниже примере пороговое усилие 
было установлено на 40,000 ф.у. (1915 кПа). 

 

График тягового усилия 

Вы можете изменять реперные точки и флажки данных на графике усилий точно так же как 
на графике давления-тягового усилия (см. предыдущий раздел). 

В руководстве пользователя системы F5 TensiTrak DigiTrak в полном объёме приводятся 
инструкции по использованию программы LWD с системой TensiTrak. 

http://www.digitrak.com/customerservice/downloads.html
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Реперные точки буровой системы DataLog 

Для просмотра данных, записанных в конкретной реперной точке наведите на неё указатель 
мыши. Для вывода на экран соответствующей строки таблицы реперных точек щёлкните на 
реперной точке на профиле трассы. Пробелы в ряду реперных точек означают отсутствие 
данных. 

Цвета и типы этих точек имеют следующие значения:  

Зелёные  
реперные точки В этих точках зарегистрирован средний показатель давления 

для данной штанги и для всех записанных и удалённых ранее 
штанг 

Синие  
реперные точки В этих точках зарегистрирован высокий показатель давления 

для данной штанги и для всех записанных и удалённых ранее 
штанг. Этот показатель рассчитывается как средняя величина 
плюс 1 среднеквадратическая погрешность. При условии 
нормального распределения эта величина будет включать в 
себя 84% показаний. Статистически это означает наличие 
нескольких участков с превышением этого показателя 
давления. 

Золотые  
реперные точки В этих точках зарегистрированы максимальные показатели 

давления для данной штанги и для всех записанных и 
удалённых ранее штанг 

Выделенные  
реперные точки Точки с показанным за ними зелёным кольцом означают, что в 

процессе сбора данных в этих местах были удалены штанги. 

Данные о давлении нельзя удалить. В случае регистрации пикового уровня давления на 
удалённой впоследствии штанге, пиковое значение давления будет перенесено на 
следующую зарегистрированную штангу. Для идентификации случаев пикового уровня 
давления требуется запись данных давления и последующая загрузка этих данных в виде 
файла давления-тягового усилия. В этом файле все зарегистрированные и удалённые 
штанги будут отмечены маркировочными флажками. 

Сохранение, распечатка и отправка операций в 
программе LWD 

Сохранение файлов проектов 

Чтобы сохранить проект щёлкните на кнопку Сохранить  (в меню File > Save (Файл> 

Сохранить)). Если Вы сохраняли данный файл ранее, то он будет повторно сохранён в том 
же месте и под тем же именем. Если файл ранее не сохранялся, введите имя и выберите 
место для хранения файла в диалоговом окне Save As (Сохранить как) и щёлкните на 
кнопку Save (Сохранить). 

По умолчанию система присваивает файлам имена DrillData#.dl5 в случае файлов с 
данными буровых работ и Pressure-Tension#.dl5 для файлов давления-тягового усилия. В 
обоих случаях вместо "#" автоматически указываются порядковые номера, начиная с 1. 

Чтобы сохранить открытый файл с другим именем или в другом месте, используйте 
функцию меню File > Save As. Измените имя и место хранения файла по своему желанию и 
щёлкните на кнопку Save. 
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Чтобы сохранить данные в виде текстового файла данных с разделителями-запятыми 
(*.csv) в кодировке Unicode для последующего использования в электронных таблицах, 
щёлкните на Экспорт в электронную таблицу  (в меню File > Export Spreadsheet (Файл 
> Экспорт в электронную таблицу)). 

Фирмой DCI рекомендуется сохранять копию окончательного варианта файла каждой 
операции в отдельную папку в качестве резервной копии. 

Распечатка и предварительный просмотр файлов проектов 

Для распечатки данных операции щёлкните на кнопку Распечатать  (в меню File > Print 

(Файл > Распечатать)). Фирмой DCI рекомендуется использовать кнопку Properties 
(Свойства) и выбрать Landscape (Альбомную) ориентацию. 

Для предварительного просмотра страниц перед распечаткой щёлкните на кнопку 
Предварительный просмотр  (в меню File > Print Preview (Файл > Предварительный 

просмотр)). В окне предварительного просмотра Вы можете щёлкнуть на кнопку Print, 
которая открывает диалоговое окно печати или на кнопку Close (Закрыть) чтобы 

переключиться обратно на файл. 

Если Вам необходимо изменить параметры распечатки, например, указать конкретный 
принтер, размер бумаги и ориентацию страницы, щёлкните на кнопку Настройка печати  

(в меню File > Print Setup (Файл > Настройка печати)). 

На первой странице распечатки указывается общая информация об операции, такая как 
место проведения работ, клиент и информация о подрядчике, а также статистические 
данные об операции и примечания. На второй странице распечатываются профиль и план 
трассы. Начиная с третьей страницы на распечатке перечисляются данные 
топографической съёмки и данные буровых работ. Удалённые реперные точки не 
показываются. 

Отправка файлов проектов 

Ваши файлы проектов LWD могут быть открыты всеми кто имеет программу LWD DigiTrak. 

Чтобы отправить отчёт клиенту у которого нет программы LWD, установите драйвер печати 
PDF

2
 и выполните распечатку на этом "принтере". Полученный в результате отчёт можно 

просмотреть на любом средстве чтения PDF-файлов. 

Альтернативой создания PDF-файла является имеющийся в списке принтеров драйвер 
"Средство записи XPS-документов (Майкрософт)". Для того чтобы открыть этот файл (XPS) 
без специальных программных средств Вашему клиенту потребуется использовать Microsoft 
Internet Explorer. Вы можете получить дополнительную информацию об использовании 
этого формата по адресу: http://windows.microsoft.com/en-US/windows-vista/Print-to-the-
Microsoft-XPS-Document-Writer. 

                                                        

2
 В число популярных программ входят Adobe Acrobat, PrimoPDF, Bullzip PDF и FoxIt PDF. Многие из этих 
программ имеют бесплатные версии. 

http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
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После того, как Вы установите драйвер печати PDF (или если Вы предпочтёте использовать 
средство записи XPS): 

1. Щёлкните на кнопку Распечатать  (в меню File > Print (Файл > Распечатать)). 

2. Используя раскрывающийся список Name (Имя) выберите Ваш драйвер печати PDF 
или средство записи XPS-документов. 

 

3. Щёлкните на кнопку Свойства, выберите альбомную ориентацию Landscape 
(рекомендуемая ориентация), и щёлкните на OK чтобы сохранить выбранную 
ориентацию и закрыть диалоговое окно Properties. 

4. Щёлкните на кнопку OK чтобы распечатать отчёт (создать файл). 

5. Выберите папку в которой Вы хотите сохранить файл и введите File Name (Имя 
файла). 

6. Щёлкните на кнопку Save (Сохранить). 

В зависимости от свойств Вашего принтера, новый файл может автоматически открыться на 
экране или Вам может потребоваться найти и открыть его самостоятельно. Для большей 
части пользователей удобнее всего будет переслать файл PDF своим клиентам в качестве 
приложения по электронной почте. 

Выберите драйвер 
принтера в этом 

раскрывающемся списке 

Выберите Альбомную 
ориентацию в свойствах 

принтера 
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Приложение A - Символы меню системы 
DataLog 

Перечисленные ниже функции меню выполняют идентичные действия для стандартных 
функций Буровой системы DataLog и для функций давления-тягового усилия (Р-Т) системы 
DataLog. Указанные ниже номера страниц обозначают первую страницу этого руководства 
на которой имеется упоминание конкретной кнопки. 

Кнопки перечисляются в алфавитном порядке. 

 

Включение/Выключение системы DataLog – Когда на экране высвечено 

сообщение "Enabled, click to disable" (Включено, нажмите чтобы выключить), то 
значок системы высвечен зелёным цветом, функция DataLog включена и Вы 
можете использовать функции меню DataLog на экране Локации. Когда на 

экране высвечено сообщение "Disabled, click to enable" (Выключено, нажмите 
чтобы включить), то значок системы высвечен красным цветом, функция 
DataLog выключена и система не будет записывать никаких данных. Стр. 4. 

 

Добавить точку наблюдения – Запись разницы отметок (контрольной 

отметки) между точками входа и выхода трассы. Наличие этого значения 
позволит построить в программе LWD более точный профиль трассы. Стр. 20. 

 

Загрузка операции – Выполняет загрузку операции системы DataLog в 

компьютер с установленной программой LWD DigiTrak. В приёмнике может 
храниться до 50 операций DataLog каждого типа (файлов буровых работ или 
файлов давления-тягового усилия). Стр. 26. 

 

Закрыть операцию – Сохраняет и закрывает операцию системы DataLog. 

Операцию можно просмотреть, дополнить данными и загрузить в компьютер 
до тех пор, пока она не будет удалена из списка операции. Стр. 16. 

 

Зарегистрировать флажок – Регистрация флажка во время записи операции 

Р-Т системы DataLog. Флажки могут регистрироваться с фиксированными 
интервалами или на конкретных точках трассы. Они используются для 
облегчения привязки физических точек к записанным реперным точкам. Стр. 
23. 

 

Пауза операции – Открывает Главное меню приёмника, но операция остаётся 

открытой и записи данных не происходит. Приёмник возобновляет запись 
данных текущей операции когда Вы повторно переключитесь на экран 
Локации без выключения приёмника. Стр. 16. 

 

Подтвердите удаление  – Выводится на экран после команды на удаление 

операций для подтверждения удаления. Нажмите на кнопку чтобы 
подтвердить удаление или на Exit (Выход) чтобы отменить удаление. Стр. 28. 

 

Продолжение существующей записи операции – Продолжить добавление 

данных к существующей операции системы DataLog. Выберите номер 
операции из списка. Стр. 17. 

 

Создать новую операцию – Создаёт новую операцию системы DataLog. В 

случае работы с функцией Буровой системы DataLog программа попросит Вас 
ввести длину штанг для данной операции. При работе с функцией давления-
тягового усилия системы DataLog на дисплее включится экран Локации и 

программа начнёт запись данных. Страницы 10 (буровая система) и 22 (P-T). 

 

Удалить все операции – Удаление всех сохранённых в приёмнике операций. 

Стр. 28. 
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Удалить операцию – Удаление выбранных операций DataLog из приёмника. 

Также используется в меню Удаления Операций для выбора одной 
подлежащей удалению операции. Стр. 28. 

Перечисленные ниже функции меню предназначены только для работы с Буровой системой 
DataLog.  

 

Данные при частичной штанги – Запись реперной точки после окончания 

бурения частичной штанги. Рекомендуется использовать в случае 
значительного изменения продольного угла наклона при выполнении бурения 
с длинными штангами или для точной регистрации небольших изменений 
топографии. Стр. 15. 

 

Запись только продольного угла наклона – Запись только продольного угла 

наклона в реперной точке. Используется в тех случаях, когда приёмник нельзя 
расположить над передней точкой локации FLP или над линией локации LL. В 
случае отсутствия информации о продольном угле наклона эта функция 
становится недоступной. В этом случае Вы должны зарегистрировать штангу 
без данных. Стр. 13. 

 

Запишите глубину/продольный угол наклона – Запись реперной точки с 

информацией о глубине и о продольном угле наклона в передней точке 
локации (FLP) или на линии локации (LL). Эта функция не используется с 
реперной точкой первой штанги, а также в тех случаях, когда отсутствует 
информация о продольном угле наклона или о глубине. Стр. 14. 

 

Запишите штангу без данных – Запись реперной точки без указания 

продольного угла наклона или глубины. Эта функция используется когда 
приёмник нельзя поместить в диапазоне действия зонда. Стр. 14. 

 

Настройка операции – Создание новой операции или продолжение записи 

существующей операции. Эта функция доступна только при включённой 
системе DataLog. Если операция Буровой системы DataLog ещё не была 
начата, эту функцию также можно включить с экрана Локации удерживая 
кнопку и нажав переключатель вправо.  

 

Просмотр операции DataLog – Вывод на экран информации о конкретной 

операции. Стр. 8. 

`  

Просмотр/удаление данных штанги – Показывает все реперные точки. 

Может использоваться для удаления последней записанной реперной точки. 
Стр. 18. 
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Приложение В - Меню 

Строка меню и панели инструментов 

Многие из функций меню программы LWD аналогичны функциям других программ системы 
Windows и некоторые из них имеют отдельные значки на панели инструментов. Вы можете 
навести курсор на любой из значков в программе LWD чтобы получить подсказку с 
описанием его функции. Неактивные значки или функции меню не имеют отношения к 
загруженному типу файла системы DataLog. Указанные ниже номера страниц обозначают 
первую страницу этого руководства на которой имеется упоминание конкретной команды. 

Меню File (Файл) 

Команда Значок Описание 

New 
 

(Новый) Создание новой буровой операции (с данными буровых 
работ, давления-тягового усилия или наведения). После выбора 
операции на экран выводится пустой экран операции. Стр. 26. 

Open 
 

(Открыть) Открывает существующую операцию. Стр. 29. 

Save 
 

(Сохранить) Сохраняет открытую операцию. Если операции ещё не 
было присвоено имя или она ещё не была сохранена, то эта 
команда открывает то же диалоговое окно, что и команда Save As 
(Сохранить как). Стр. 46. 

Save As  (Сохранить как) Сохраняет текущую операцию в файле с 
указанным именем и в указанной папке. Стр. 46. 

Print  (Распечатать) Распечатка операции. Стр. 47. 

Print Preview  (Предварительный просмотр) Показывает операцию на экране так, 
как она будет выглядеть на распечатке. Стр. 47. 

Print Setup  (Настройка печати) Настройка таких параметров как принтер, 
размер бумаги и ориентация страницы. Аналогичные функции, как 
правило, имеются в диалоговом окне Распечатать ОС Windows, 
которое открывается кнопкой Properties (Свойства). Стр. 47. 

Import 
Eclipse Data 

 (Импорт данных из системы Eclipse) Выполняет импорт данных 
системы DataLog Eclipse (*.dld) или Eclipse TensiTrak (*.ttd). 

Export 
Spreadsheet 

 (Экспорт в электронную таблицу) Выполняет экспорт данных в виде 
текстового файла данных с разделителями-запятыми (*.csv) для 
использования в электронных таблицах. Стр. 47. 

Upload 
Control 

 (Контроль загрузки) Подключение к приёмнику DigiTrak для загрузки 
данных. Стр. 26. 

File 1, 2…  (Файл 1, 2...) Открывает недавно использовавшийся файл. 

Exit  (Выход) Выход из программы LWD DigiTrak. 
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Меню Edit (Правка) 

Команда Значок Описание 

Site 
Information  

(Информация об участке) Ввод и правка общей информации об 
участке, контактной информации и примечаний, которые 
указываются в окне Site Information в верхнем левом углу 
программы. Быстрое переключение на команду: двойной щелчок на 
окне Site Information. Стр. 30. 

Display Units 
 

(Единицы измерения) Выберите показываемые на графиках LWD 
единицы измерения глубины, продольного угла наклона, 
температуры и давления/тягового усилия. Показываемые единицы 
устанавливаются в соответствии с настройкой единиц глубины на 
приёмнике. Стр. 29. 

Job 
Information  

(Информация об операции) Просмотр и правка информации об 
операции, включая длину штанг, информации о точках наблюдения 
для файлов с данными буровых работ и информации об 
устанавливаемом продукте для файлов давления-тягового усилия. 
Это диалоговое окно выводится на экран сразу после загрузки 
файла системы DataLog. Быстрое переключение на команду: 
двойной щелчок на окне Job Information. Стр. 31. 

Profile  
Chart 
Annotations 

 
(Примечания профиля трассы) Для добавления примечаний и 
рисунков, которые будут показаны на профиле трассы. Быстрое 
переключение на команду: Нажмите и удерживайте кнопку Shift и 
перетащите окно на график. Стр. 34. 

Pressure 
Chart 
Annotations 

 
Для добавления примечаний и рисунков, которые будут показаны 
на графике давления. Быстрое переключение на команду: Нажмите 
и удерживайте кнопку Shift и перетащите окно на график. Стр. 34. 

Force  
Chart 
Annotations 

 
(Примечания графика усилий) Для добавления примечаний и 
рисунков, которые будут показаны на графике усилий. Быстрое 
переключение на команду: Нажмите и удерживайте кнопку Shift и 
перетащите окно на график. Стр. 34. 

Profile  
Chart 
Properties 

 
(Свойства профиля трассы) Регулировка масштаба профиля 
трассы. Стр. 35. 

Pressure 
Chart 
Properties 

 
(Свойства графика давления) Регулировка масштаба графика 
давления. Стр. 35. 

Force  
Chart 
Properties 

 
(Свойства графика усилий) Регулировка масштаба графика усилий. 
Стр. 35. 

Utility Flags 
 

(Флажки коммунальных сетей) Добавление, изменение или 
удаление имеющих отношение к коммунальным сетям флажков и 
данных. Стр. 40. 

Data Flags 
 

(Флажки данных) Изменение или удаление флажков данных Р-Т. 
Стр. 44. 

Меню View (Вид) 

Команда Значок Описание 

Toolbar  (Панель инструментов) Показывает или прячет панель 
инструментов. 

Status Bar   (Строка состояния) Показывает или прячет строку состояния. 

Bluetooth 
Device List   

(Список устройств Bluetooth) Показывает список 
зарегистрированных устройств Bluetooth. Стр. 25. 
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Меню Window (Окно) 

Команда Значок Описание 

New Window  (Новое окно) Открывает текущий файл в новом окне. 

Cascade  (Каскадом) Выстраивает окна на экране в виде каскада. 

Tile  (Мозаика) Выстраивает окна на экране в виде мозаики. 

Arrange 
Icons 

 (Упорядочить значки) Упорядочивает значки свёрнутых окон. 

Window  
1, 2… 

 (Окно 1, 2…) Переключение на указанное окно. 

Меню Help (Справка) 

Команда Значок Описание 

Help Topics 
 

(Разделы справки) Указатель разделов справки. Стр. 29. 

About 
DigiTrak LWD 

 (Информация о программе LWD DigiTrak) Показывает номер версии 
программного обеспечения DigiTrak LWD. 
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ОГРАНИЧЕННЫЕ ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА 

Фирма Digital Control Incorporated («DCI») гарантирует, что при поставке фирмой DCI каждое изделие фирмы DCI (за исключением 
программного обеспечения) соответствует опубликованным на момент поставки спецификациям DCI и на весь срок гарантии («Гарантийный 
срок»), указанный ниже, не имеет дефектов материалов или изготовления. В дополнение к этому, фирмой DCI гарантируется, что всё 
программное обеспечение фирмы DCI будет в общем и целом соответствовать всем приводимым в документации спецификациям на 
программное обеспечение на протяжении указанного ниже Гарантийного срока. Изложенные здесь ограниченные гарантийные обязательства 
(«Ограниченные гарантийные обязательства») не подлежат передаче, они распространяются только на первого конечного пользователя 
(«Пользователь»), приобретающего изделие DCI у фирмы DCI или у дилера, авторизованного фирмой DCI на продажу изделий DCI 
(«Авторизованный дилер DCI»). 

На эти ограниченные гарантийные обязательства распространяются следующие сроки, условия и ограничения: 

1. Гарантийный срок двенадцать (12) месяцев распространяется на следующие новые изделия DCI: приемники/локаторы, дистанционные 
дисплеи, зарядные устройства для аккумуляторов и сами аккумуляторы, программное обеспечение и приложения. Гарантийный срок 
девяносто (90) дней распространяется на все прочие новые изделия DCI, включая зонды и принадлежности. Гарантийный срок 
девяносто (90) дней также распространяется на все предоставляемые фирмой DCI услуги, включая контрольные испытания, 
обслуживание и ремонт вышедших из-под гарантии изделий DCI. Гарантийный срок начинается с наиболее поздней из следующих дат: 
(i) с даты отгрузки изделия DCI фирмой DCI или (ii) с даты отгрузки (или иной доставки) изделия DCI Авторизованным дилером DCI 
Пользователю. 

2. Если функционирование изделия фирмы DCI (за исключением программного обеспечения) не будет соответствовать условиям 
гарантии в течение Гарантийного срока, фирмой DCI будет выполнена контрольная проверка изделия и если фирмой DCI будет 
выявлен дефект такого изделия, то по самостоятельному выбору фирмы DCI такое изделие будет либо отремонтировано, либо 
заменено. Если функционирование программного обеспечения фирмы DCI не будет соответствовать условиям гарантии в течение 
Гарантийного срока, то по самостоятельному выбору фирмы DCI такое программное обеспечение будет либо обновлено для его 
материального соответствия спецификациям на программное обеспечение, либо Пользователю будет возвращена та сумма, которая 
была уплачена за дефектное программное обеспечение. ВЫШЕУПОМЯНУТЫЕ МЕРЫ ПРЕДСТАВЛЯЮТ СОБОЙ ЕДИНСТВЕННЫЕ И 
ИСКЛЮЧИТЕЛЬНЫЕ МЕРЫ КОМПЕНСАЦИИ ПОЛЬЗОВАТЕЛЮ ЗА НАРУШЕНИЕ ДАННЫХ ОГРАНИЧЕННЫХ ГАРАНТИЙНЫХ 
ОБЯЗАТЕЛЬСТВ. Все гарантийные контрольные проверки, ремонт и регулировка должны выполняться либо самой фирмой DCI либо 
предприятием, занимающимся оценкой гарантийных рекламаций и имеющим соответствующее письменное разрешение фирмы DCI. 
Все гарантийные рекламации должны подаваться в комплекте с доказательствами покупки, включая доказательства даты покупки, а 
также должны включать в себя серийный номер изделия DCI и должны подаваться не позднее даты истечения Гарантийного срока. 

3. Данные ограниченные гарантийные обязательства будут считаться действительными только в следующих случаях:(i) в случае, если в 
течение четырнадцати (14) дней после получения изделия DCI Пользователем будет выполнена регистрация изделия DCI в фирме DCI 
на регистрационном сайте продукции по адресу access.DigiTrak.com; (ii) в случае, если при получении изделия DCI Пользователем 
будет выполнена надлежащая контрольная проверка изделия и он незамедлительно уведомит фирму DCI об обнаруженной явной 
неисправности изделия; и (iii) в случае, если Пользователем будут выполнены все условия описываемой ниже Процедуры подачи 
гарантийной рекламации. 

Гарантия не распространяется на следующие случаи 

Настоящие Ограниченные гарантийные обязательства не распространяются на все повреждения, включая повреждения любого изделия DCI, 
произошедшие по причине несоблюдения положений руководства пользователя DCI и иных инструкций DCI; эксплуатация изделий DCI в 
условиях, выходящих за рамки эксплуатационных спецификаций для данного изделия (включая, помимо прочего, температурные условия); 
злоупотребления, неправомерное использование; небрежность; несчастные случаи; пожар; наводнение; природные катаклизмы; 
неправильное использование; подключение к электросети неправильного напряжения, а также к неправильным источникам электропитания, 
использование неправильных предохранителей, перегрев, контакт с источниками высокого напряжения или с агрессивными химикатами, 
использование аккумуляторов и прочих изделий, которые не были произведены или не поставлялись фирмой DCI, а также прочие события, 
выходящие за пределы контроля фирмы DCI. Настоящие Ограниченные гарантийные обязательства не распространяются на любое 
оборудование, не произведенное или не поставляемое фирмой DCI, а также, при выполнении соответствующих условий, на любые 
повреждения или ущерб вследствие использования какого-либо изделия DCI вне страны поставки. Пользователем принимаются 
обязательства по выполнению полной оценки пригодности изделия фирмы DCI для целевого использования и по внимательному 
ознакомлению и строгому выполнению всех поставляемых фирмой DCI инструкций (включая всю новую дополнительную информацию об 
изделии фирмы DCI, которую можно получить на сайте фирмы DCI). Ни в коем случае настоящие Ограниченные гарантийные обязательства 
не распространяются на какой-либо ущерб, возникший в процессе транспортировки изделия DCI на фирму DCI или от нее. 

Пользователь соглашается, что приведенные выше Ограниченные гарантийные обязательства аннулируются в следующих случаях:(i) при 
изменении, уничтожении или подделке любого заводского или серийного номера, идентификационных, инструктирующих или пломбирующих 
этикеток на изделии DCI или (ii) при любом несанкционированном демонтаже, ремонте или модификации изделия DCI. Ни в коем случае 
фирма DCI не несет ответственности за расходы или любой ущерб, вызванные любыми изменениями, модификациями или ремонтными 
действиями с изделием DCI, произведенными без специального письменного разрешения со стороны фирмы DCI. В дополнение в этому 
фирма DCI не несет ответственности за ущерб и повреждение изделия DCI или любого другого оборудования, находящегося в распоряжении 
какой-либо сервисной службы, не имеющей соответствующего разрешения фирмы DCI. 

Фирма DCI не гарантирует точности или полноты показываемых, или вычисляемых системами ГНБ данных или информации. Точность или 
полнота такой информации может зависеть от целого ряда факторов, включая (без ограничений) активные или пассивные помехи (включая 
помехи от солёной воды), а также прочие условия окружающей среды, неправильную или невыполненную калибровку, или неправильную 
эксплуатацию устройства, а также прочие факторы. Фирмой DCI также не гарантируется и не принимается никакой ответственности за 
точность или за полноту каких-либо полученных от любых внешних устройств данных, или за данные, которые были вычислены исходя из 
каких-либо полученных от любых внешних устройств данных и показанных на устройстве фирмы DCI, включая (без ограничений) все данные, 
полученные от любых буровых установок ГНБ. 

Фирма DCI оставляет за собой право время от времени вносить изменения в конструкцию и усовершенствовать изделия DCI, а Пользователь 
понимает, что фирма DCI не обязана совершенствовать ранее произведенные изделия DCI для внесения в них таких изменений. 

mailto:dci@digital-control.com
http://www.digitrak.com/
http://access.digitrak.com/
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ИЗЛОЖЕННЫЕ ВЫШЕ ОГРАНИЧЕННЫЕ ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА ЯВЛЯЮТСЯ ЕДИНСТВЕННЫМ ОБЯЗАТЕЛЬСТВОМ 
ФИРМЫ DCI И ДАНЫ ВМЕСТО ВСЕХ ИНЫХ ОБЯЗАТЕЛЬСТВ, ЯВНО ВЫРАЖЕННЫХ ИЛИ ПОДРАЗУМЕВАЕМЫХ, В ТОМ ЧИСЛЕ, НО НЕ 
ТОЛЬКО, ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ НА ПРИГОДНОСТЬ К ПРОДАЖЕ И ПРИГОДНОСТЬ ДЛЯ КОНКРЕТНОГО ПРИМЕНЕНИЯ, 
ПОДРАЗУМЕВАЕМОЙ ГАРАНТИИ СОБЛЮДЕНИЯ ПРАВ, И ЛЮБЫХ ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ, ВОЗНИКАЮЩИХ В ХОДЕ 
ЭКСПЛУАТАЦИИ, В ХОДЕ КОММЕРЧЕСКОЙ ДЕЯТЕЛЬНОСТИ ИЛИ В ХОДЕ ИСПОЛЬЗОВАНИЯ ПО НАЗНАЧЕНИЮ. ДАННОЕ 
ЗАЯВЛЕНИЕ ЯВЛЯЕТСЯ ОТКАЗОМ ОТ ОТВЕТСТВЕННОСТИ И ИСКЛЮЧЕНИЕМ ИЗ ОБЯЗАТЕЛЬСТВ ВСЕХ ВЫШЕУПОМЯНУТЫХ 
СЛУЧАЕВ. В случае, если фирмой DCI будут материально выполнены все описываемые ниже действия по обеспечению процедур 
гарантийных рекламаций, эти действия будут представлять собой единственную и исключительную компенсацию Пользователю за 
нарушение положений данных Ограниченных гарантийных обязательств. 

Ограничения средств правовой защиты и обязательства 

Ни в коем случае ни фирма DCI, ни какая-либо иная организация, связанные с созданием, производством или поставкой изделия 
DCI, не несут ответственности за какой-либо ущерб, возникший вследствие использования или невозможности использования 
изделия DCI, в том числе (не ограничиваясь только перечисленным) за косвенные, особые. случайные или побочные убытки или 
за какое-либо страхование, потерю информации, прибыли, дохода или использование на их основе какого-либо иска со стороны 
Пользователя за нарушения гарантийных обязательств, нарушения контракта, небрежность, излишне четкого выполнения 
обязательств или любой иной правовой теории, даже если фирма DCI была уведомлена о возможности такого ущерба. Ни в коем 
случае ответственность фирмы DCI не может превышать суммы средств, уплаченных Пользователем за изделие DCI. В той мере, в 
какой любой применяемый закон не допускает исключения или ограничения случайных убытков, ущерба в виде последствий и т.п. 
убытков, вышеизложенные ограничения, касающиеся подобных убытков, не должны применяться. 

Настоящие Ограниченные гарантийные обязательства предоставляют Пользователю особые юридические права, кроме того, Пользователь, 
возможно, обладает иными правами, которые могут быть различными в разных странах. Настоящие Ограниченные гарантийные 
обязательства подлежат интерпретации в соответствии с законодательством штата Вашингтон США. 

Процедуры подачи гарантийной рекламации 

1. Если у Вас возникнут какие-либо вопросы относительно эксплуатации Вашего изделия фирмы DCI, Вы должны обратиться сначала к 
авторизованному дилеру фирмы DCI у которого было куплено данное изделие. Если авторизованный дилер фирмы DCI не сможет 
решить возникших у Вас вопросов, тогда обратитесь в службу по работе с клиентами фирмы DCI в городе Кент, штат Вашингтон, США 
по тел. 1.800.288.3610 (в случае, если Вы находитесь за пределами США, воспользуйтесь номером телефона для Вашей страны) и 
попросите Вас соединить с представителем службы по работе с клиентами. Телефонные линии работают с 06:00 до 18:00 по 
Тихоокеанскому стандартному времени. Перед возвратом какого-либо изделия DCI на фирму DCI для обслуживания Вы должны 
получить номер разрешения на возврат товара (RMA). Отсутствие такого номера может привести к задержке или возврату Вам изделия 
DCI без ремонта. 

2. После разговора по телефону с представителем службы по работе с клиентами фирмы DCI, представитель попытается помочь Вам в 
устранении неисправности в условиях реальной эксплуатации изделия DCI. Пожалуйста, подготовьте к работе всё требуемое для 
работы оборудование и составьте перечень серийных номеров всех изделий DCI. Важно осуществить поиск и устранение 
неисправности в ходе реальной работы, поскольку множество неисправностей возникает не из-за дефектов изделий DCI, а в силу 
ошибочных операций управления или в силу неблагоприятных условий бурения на площадке Пользователя. 

3. Если в результате эксплуатационных проверок и обсуждения возникших вопросов с представителем службы по работе с клиентами 
фирмы DCI будет подтверждена неисправность изделия DCI, представитель присвоит изделию номер RMA, предоставляющий право 
на возврат этого изделия DCI, и предоставит указания по его транспортировке. Вы сами отвечаете за оплату транспортировки, включая 
все расходы на страховку. Если после получения фирмой DCI изделия и выполнения соответствующих диагностических проверок будет 
установлено, что возникшая проблема попадает под действие Ограниченных гарантийных обязательств, то фирмой будет выполнен 
требуемый ремонт и/или регулировка изделия и Вам будет незамедлительно отправлено полностью работоспособное изделие DCI. 
Если выявленная неисправность не подпадает под действие Ограниченных гарантийных обязательств, Вы будете проинформированы 
о причинах и Вам будет предоставлена смета расходов на ремонт. Если Вы разрешите фирма DCI выполнить обслуживание или 
ремонт изделия DCI, все работы будут выполнены незамедлительно и изделие DCI будет отправлено Вам обратно. Вам будет 
выставлен счет за все расходы по выполнению всех не предусмотренных Ограниченными гарантийными обязательствами контрольных 
испытаний, ремонта и регулировки, а также за транспортные расходы. В большинстве случаев срок ремонта не превышает 1-2 недель. 

4. Фирма DCI ограничена в возможностях предоставления арендуемого оборудования. Если Вам необходимо арендуемое оборудование и 
такое оборудование имеется в наличии, фирма DCI постарается отправить Вам арендуемое оборудование со срочной доставкой. 
Арендуемое оборудование предоставляется на время выполнения обслуживания Вашего оборудования фирмой DCI. Фирма DCI 
приложит все приемлемые усилия, чтобы сократить вызванное гарантийной рекламацией время простоя Вашего оборудования. Это 
время может зависеть от неподконтрольных фирме DCI обстоятельств. Если фирма DCI предоставит Вам арендуемое оборудование, 
Ваше оборудование должно быть получено фирмой DCI не позднее, чем на второй рабочий день после того, как Вы получите 
арендуемое оборудование. Вы должны возвратить арендуемое оборудование, используя срочную доставку, чтобы фирма DCI получила 
его не позднее чем на второй рабочий день после получения Вами отремонтированного изделия DCI. При несоблюдении указанных 
сроков будет взыскана арендная плата за пользование арендуемым оборудованием за каждые сутки задержки его возврата фирме DCI. 

Демонстрационный показ изделия 

Сотрудники DCI могут присутствовать на месте проведения работ с целями демонстрации основных методов эксплуатации, функций и 
преимуществ в использовании изделий фирмы DCI. Пользователем признаётся тот факт, что целью присутствия сотрудников фирмы DCI 
является только демонстрация изделия фирмы DCI. Фирмой DCI не предоставляется услуг по выполнению локационных работ и не 
предоставляется прочих консультационных или подрядных работ. Фирмой DCI не принимается никаких обязательств по обучению 
Пользователей или прочих сотрудников и не принимается никакой ответственности или обязанностей за выполнение локации или прочих 
работ на конкретной площадке на которой находятся или будут находиться сотрудники или оборудование фирмы DCI. 

Данный документ является переводом оригинального варианта документа на английском языке. Данный перевод предназначен 
для удобства пользователей изделия. В случае каких-либо расхождений в значениях или в интерпретации положений между 
переводом и оригинальной версией на английском языке, оригинальная версия на английском языке будет обладать 
преимущественным правом. Вы можете найти оригинальную версию данного документа на сайте фирмы по адресу 
www.DigiTrak.com. В разделе Service & Support (Обслуживание и работа с клиентами), нажмите на Documentation (Документация) и 
выберите требуемое руководство в раскрывающемся меню Manuals (Руководства). 

http://www.digitrak.com/

